
Computer Dictionary 
for Absolute Beginners

 

To use the Computer Dictionary, place your mouse on the push button above that corresponds with the first
letter of the word you want to look up and press the left mouse button once.    Symbols (*) and Numbers (#) are 
also available.    Once you find the word you want, place the mouse on that word and press the left mouse 
button once to display the definition of that word.

Register this Shareware
Shareware is a distribution method, not a type of software.    Shareware distribution gives users a chance 

to try software before buying it. If you try a Shareware program and continue using it, you are required to 
register it.    Place your mouse on the word "Register" above and press the left mouse button once to display 
the registration form for this shareware.

View Readme File
The Readme file contains the installation instructions, description of the support policy, a definition of 

shareware and the Agreement for this shareware.    Place your mouse on the word "Readme" above and press 
the left mouse button once to display the readme file for this shareware.
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 @ function
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Numbers
286

386

386 enhanced mode

486

80286

80287

80386

80387

80486

8080

8086

8088
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A
About

AC

access method

Access Control (AC)

access time

accounting management

active device

active icon

active window

adapter

address

allocation unit

alphanumeric

ALT key

analog

analog recording

animated icon

animation



ANSI character set

ANSI.SYS

API

APPEND

application

application icon

application program

Application Program Interface (API)

application software

archive

archive attribute

ARCnet

Arrange

arrow keys

ASCE

ASCII

ASCII character set

assembly language

associate

Association Control Service Element (ASCE)

asterisk (*)

asynchronous transmission



at sign

ATTRIB

attribute

audio file

audit trails

AUTOEXEC.BAT

Available Space
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B
backbone

background

backslash (\)

BACKSPACE key

backup

BACKUP

bandwidth

baseband

BASIC

BAT

batch file

baud

baud rate

BBS

bi-directional printing

binary

binary code

binary digit

binary file



binary transfer

BIOS

bit

bitmap

bitmap graphics

bits per second (BPS)

bitwise

block command

BMP

BNC

board

bookmark

boot

boot disk

Boot PROM

Boot Programmable Read Only Memory (Boot PROM)

bootable disk

bootstrap

border

BPS

branch

BREAK

bridge



broadband

broadcast

brouter

browse

buffer

BUFFERS

bug

bulletin board system

bus

bus topology

button

byte
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C
C

C++

cache

CALL

capacity

CAPS LOCK key

carat

card

Carrier Sense Multiple Access with Collision Avoidance (CSMA/CA)

Carrier Sense Multiple Access with Collision Detection (CSMA/CD)

cartridge font

Cascade

cascaded menu

cascading choice

case

case sensitive

CD - CHDIR

CD-ROM



Central Processing Unit (CPU)

CGA

CGM

character

character set

check box

check mark

chip

chip set

CHKDSK

choice

CHOICE

choose

circuit

clear

click

client

client application

client-server computing

clipboard

clock

clock speed



clone

close

Close

CLS

cluster

CMOS

coaxial cable

COBOL

code

cold boot

collapse

colon (:)

color scheme

COM

COM port

command

COMMAND

command button

command line

command prompt

common carrier

communication program



communication settings

COMP

compact disc

compatible

concurrency control

condensed printing

CONFIG.SYS

configuration

configure

confirmation message

container

contention

Contents

context sensitive help

continuous paper (continuous feed paper)

control code

control menu

controller

conventional memory

copy

Copy

COPY



copy protection

COUNTRY

CPU

CRC

CRT

CSMA/CA

CSMA/CD

CTRL key

CTRL+ALT+DEL

CTRL+BREAK

CTRL+C

current directory

cursor

cursor keys

cut

Cut

cutout

cut-sheet feeder

Cyclical Redundancy Check (CRC)
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D
DAT

data

Data Communications Equipment (DCE)

data compression

Data Encryption Standard (DEQ)

data file

data integrity

data processing

database

database server

DATE

DB-9A

DB-15A

DB-25A

dBase

DBLSPACE

DCE

DD

DDD



DDE

DEBUG

debugging

DECnet

decode

dedicated server

default

default action

default button

default choice

default printer

default settings

DEFRAG

DEL

DEL key

delimiter

DELTREE

DES

deselect

desktop

desktop computer

desktop pattern

desktop publishing



destination directory

device

DEVICE=

device driver

DEVICEHIGH=

diagnostic

dialog box

DID

digital audio

Digital Audio Tape (DAT)

digital data

dimmed

DIP switches

DIR

Direct Distance Dialing (DDD)

Direct Inward Dialing (DID)

direct manipulation

Direct Memory Access (DMA)

direction keys

directory

directory name

directory name extension (extension)

directory tree

directory window



disc

disk

disk cache

disk drive

disk duplexing

DISKCOMP

DISKCOPY

diskette

display

display adapter

DISPLAY.SYS

dithered color

DMA

document

document file

document window

documentation

DOS

DOS=

DOS memory

DOS Protected Mode Interface (DPMI)

DOSKEY

DOSSHELL



dot matrix printer

Dots Per Inch (DPI)

double click

Double Density (DD)

double height printing

Double Sided (DS)

double strike printing

double width printing

down time

download

download characters

downloaded font

DPI

DPMI

draft

drag

drive

drive letter

driver

DRIVER.SYS

DRIVPARM

DRW

DS

dump



Dynamic Data Exchange (DDE)
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E
e-mail

ECHO

EDIT

edit control

Edit Menu

editor

EDLIN

EGA

EGA Monitor

EGA.SYS

EISA

Electromagnetic Interference / Radio Frequency Interference (EMI/RFI)

electronic mail (e-mail)

embed

embedded object

EMI/RFI

EMM386.EXE

EMS

emulation



enable

END key

End-Of-File mark (EOF)

ENTER key

environment variables

EOF

erase

ERASE

ESC key

Ethernet

EtherTalk

Ethertype

EXE

EXE2BIN

execute

Exit

EXIT

expand

EXPAND

expanded memory

expanded memory emulator

Expanded Memory Specification (EMS)

expansion card

expansion board



expansion slot

export

extend selection

extended attributes

Extended EGA

Extended Industry Standard Architecture (EISA)

extended memory

extended memory manager

Extended Memory Specification (XMS)

extension
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F
FASTHELP

FASTOPEN

FAT

fault management

fault tolerance

fax modem

FC

FCBS

FDISK

fiber optic cable

field

file

File Allocation Table (FAT)

file attribute

file format

file locking

File Menu

file name



file name extension (extension)

file server

File Transfer Access and Management (FTAM)

File Transfer Protocol (FTP)

FILES

Find

FIND

fixed disk

fixed width font

flag

flags

flexible box

flicker

floppy disk

flow control

folder

font

font cartridge

font family

font size

footer

FOR



foreground application

format

FORMAT

forward slash (/)

frame

front-end

FTAM

FTP

full screen application

function keys
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G
gateway

GIF

gigabyte

glitch

Go To

GOTO

graphics

GRAPHICS

graphics card

graphics mode

graphics resolution

grayed

group

group icon

group window
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H
handshake

hard copy

hard disk

hardware

Hayes compatible

HD

header

helical scan

help

HELP

help index

Help Menu

help push button

Hercules Graphics Card (HGC)

hertz (Hz)

heterogeneous networks

hexadecimal

HGC

Hi-res



hidden attribute

High Density (HD)
    
Hz

High Memory Area (HMA)

high-level language

highlighted

HIMEM.SYS

HMA

HOME key

horizontal scan rate

hot key

How Do I

hue
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I
I/O

I/O address

IC

icon

IF

image

impedance

import

inactive window

Industry Standard Architecture (ISA)

INI

initialization files

initialize

ink-jet printer

input

input peripheral

Input/Output address (I/O address)

input/output device

INSERT key



insertion point

install

INSTALL

instruction set

Integrated Circuit (IC)

Integrated Services Digital Network (ISDN)

interface

INTERLNK

International Standards Organization (ISO)

Internet

internetwork

interoperability

interrupt

interrupt request

Interrupt Request Lines (IRQ)

INTERSVR

IRQ

ISA

ISDN

ISO

italics
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J
jabber

job

joystick

JPEG

jumper
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K
K

KB

kernel

KEYB

keyboard

keyboard buffer

keys help

kilobyte (KB)
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L
label

LABEL

LAN

LAN Manager

LAN Server

LAN-aware

LAN-ignorant

LAN-intrinsic

language

laptop computer

Large Scale Integration (LSI)

laser printer

LASTDRIVE

LAT

LCD

leased line

LED

left click

letter quality



LH

light pen

line feed

line

link

linked object

Liquid Crystal Display (LCD)

list box

load

LOADFIX

LOADHIGH

loading position

Local Area Network (LAN)

Local Area Transport (LAT)

local printer

LocalTalk

log in

log out

logical drive letter

LOGO

loop

loopback

loosely coupled

low DOS memory



low-level language

LPT port

LSI

luminosity
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M
M

machine

machine language

macro

magnetic disk memory

main menu

MAN

Manchester encoding

Manufacturing Automation Protocol (MAP)

MAP

mapping

mark

math coprocessor

maximize

maximize button

MB

MCA

MCI

MD



MDA

Media Control Interface (MCI)

media file

megabyte (MB)

megahertz (MHz)

MEM

MEMMAKER

memory

memory resident program

menu

menu bar

message box

Metropolitan Area Network (MAN)

MHz

micro feed

micro adjustment

Micro Channel Architecture (MCA)

microcomputer

microprocessor

MIDI

MIDI file

migrate

minimize



minimize button

minimized window viewer

mirroring

mixer

MKDIR

modal dialog box

MODE

modem

modulation

monitor

monochrome monitor

monospaced font

MORE

morphing

motherboard

mount

mouse

mouse button

move

MOVE

MSAV

MSD

MS-DOS

MSBACKUP



multi-user software

multicast

multimedia

multimedia system

multiple document interface (MDI)

multiprocessor

multitasking

Musical Instrument Digital Interface (MIDI)
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N
NetBIOS

NetWare

network

network administrator

network architecture

Network Basic Input/Output System (NetBIOS)

network drive

Network Interface Card

Network Interface Controller (NIC)

Network Loadable Module (NLM)

Network Operating System (NOS)

network printer

network topology

New

NIC

NLM

NLSFUNC

node

nondedicated server



nonsolid color

nonvolatile

NOS

notebook

notebook computer

NUM LOCK key
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O
O/S

object

Object Linking and Embedding (OLE)

OCR

off-line

OLE

on-line

open

Open

operating system (O/S)

optical character recognition (OCR)

option

Options Menu

OS/2

output

output peripheral
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P
package

packet

packet filter

packet forwarding

packet switching

PAGE DOWN key

page frame

PAGE UP key

paragraph

parallel port

parallel data transmission

parallel interface

parameter

parity

parity check

partition

PASCAL

passive device

password



paste

Paste

Paste Format

Paste Link

Paste Special

path

PATH

path name

PAUSE

PAUSE key

PC

PC/AT

PCD

PC-DOS

PCMCIA (Personal Computer Memory Card International Association)

PCX

PC/XT

peer to peer

pel

Pentium

percent

performance management

peripheral



personal computer (PC)

phase modulation

physical drive letter

PIF

pin printer

pinouts

pipe

pixel

platen

plotter

plotter font

point

point size

point to point link

pointer

pointing device

polling

pop up menu

pop up program

pop up window

port

port designation

POWER

power supply



Preferences

preselected choice

Print

PRINT

print queue

PRINT SCREEN

print server

Print Set-up

print spooler

printable area

printer

printer driver

printer fonts

printer port

PRINTER.SYS

program

program file

program information file (PIF)

program item icon

program items

Program Manager

Programmed Input/Output (PIO)

prompt



PROMPT

propagation delay

proportional font

proportional printing

protected mode

protocol

protocol stack

protocol suite

publishing
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Q
QBASIC

QBE

Query By Example (QBE)

query language

question mark (?)

queue

quick format
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R
radix

RAM

RAM base address

RAM drive

RAMDRIVE.SYS

random access memory (RAM)

Random Access Memory base address (RAM base address)

raster font

RD

read

read only attribute

Read Only Memory (ROM)

real mode

real time

real time clock

record

record locking

RECOVER

redirector



reduce

refresh rate

REM

remote

Remote Procedure Call (RPC)

removable disk

REN

RENAME

repeater

Replace

REPLACE

replaceable parameters

reset

resolution

response time

RESTORE

restore button

Retrieve

RFC

RGB Monitor

right click

ring topology

RISC



RMDIR

ROM

ROM Caching

root directory

route discovery

router

RPC

RS232

run

Run
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S
save

Save

Save As

scalable typeface

scaled point size

scanner

screen

screen dump

screen font

screen saver

scroll

scroll arrow

scroll bar

scroll box

SCROLL LOCK key

SCSI

SCSI Bus Master

SCSI Host Adapter

Search



Search Menu

sector

sectors per cluster

security management

seek time

SEF

select

selection cursor

self test

semaphore

semiconductor

serial data transmission

serial interface

serial port

server

server application

session

SET

setting

SETVER

SETVER.EXE

SHARE

shared memory



shareware

SHELL

shielded

SHIFT

SHIFT key

shortcut key

shutdown

Simultaneous Peripheral Operation On-line (SPOOL)

single document interface (SDI)

Single Sided (SS)

slack space

slider

Small Computer System Interface (SCSI)

SMARTDRV.EXE

soft font

software

solid color

solid state

SORT

sound driver

sound file

source

source directory

source diskette



source document

source drive

Source Explicit Forwarding (SEF)

special characters

split bar

SPOOL

spooler

spooling

spreadsheet

SQL

SS

STACKS

standard mode

standby position

star topology

start up sequence

statement

status bar

store

store and forward

stored procedures

string

Structured Query Language (SQL)



subdirectory

subscript

SUBST

Super VGA

Super Video Graphics Array (SVGA) or Super VGA

superscript

SVGA

swap file

switch

SWITCHES

synchronous transmission

syntax

synthesizer

SYS

system

system attribute

system boot up sequence

system date

system disk

system file

system icon

system menu

system time

SYSTEM.INI file
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T
T connector

T1

tab

TAB key

tab stop

target

target directory

target diskette

target drive

task list

tear-off

tear-off position

template

terminal

Terminate and Stay Resident (TSR)

text box

text editor

text file

text mode



text transfer

Thicknet

Thinnet

threads

TIFF

tightly coupled

Tile

time slice

time slicing

TIME

timeout

title bar

title bar icon

toggle

token

token bus

token passing

Token Ring

Tools Menu

top of form

topology

total files

tower computer

track



tractor paper (tractor feed paper)

transceiver

tree topology

TREE

triggers

True Type fonts

TSR

TTL

TTL Monitor

Tutorial

twisted pair cable

type 3

type 1

TYPE
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U
UMB

UNDELETE

Undo

UNFORMAT

uni-directional printing

Uninterruptible Power Supply (UPS)

unity gain

unshielded

upload

upper memory area

Upper Memory Blocks (UMB)

UPS

used space

user

user interface

user-defined characters



Computer Dictionary 
for Absolute Beginners

 

V
value

Value Added Process (VAP)

VAP

vector font

VER

VERIFY

VESA (Video Electronics Standards Association)

VGA

video monitor

view

virtual

virtual circuit

virtual drive

virtual memory

virus

VL-Bus

VOL

volatile

volume label



VSAFE
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W
wallpaper

WAN

warm boot

waveform

Wide Area Network (WAN)

wildcard character

WIN.INI file

WIN-OS/2

window

window list

Window List

Window Menu

Windows application

Windows character set

WMF

word processing

word processor

word wrap

working copy



working directory

workspace

workstation

WPG

write

write enable notch

write protect

WYSIWYG
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X
XCOPY

XMS



Registration Form

Select the menu item above: File, Print Topic to print a copy of this form for mailing.

Please make payment by check or money order (in US funds)
payable to "Gary FitzGerald" and send to:

              Gary FitzGerald        
              553 Haverstraw Rd.
              Suffern, NY      10901

Quantity       Price    
Shareware Registration fee ($5.00/copy):        _______ _______
Printed Booklet ($7.50/copy incl. S & H*)        _______      _______
Your State Sales tax on booklet (if any)                            _______
                                  Total enclosed                                              

_______

*Shipping & handling included within the Continental United States.

Name        ________________________________________________________
Company _______________________________________________________
Address ________________________________________________________
                            ________________________________________________________
Phone      ________________________________________________________

Where did you get Computer Dictionary?    ______________________________

Comments? _____________________________________________________
_______________________________________________________________

Please specify the diskette size(s) that are acceptable for you:
                ___ 3.5" 1.44MB      ___ 3.50" 720KB
                ___ 5.25" 1.2MB      ___ 5.25" 360KB

As a registered user, you will automatically be notified of future products and you will 
receive a discount on future shareware and nonshareware prices.



Readme File

COMPUTER DICTIONARY FOR ABSOLUTE BEGINNERS
                Version 1.2    for Windows 3.1, VGA

Definitions of over 1,001 terms that every computer user should know. 
Written by Gary FitzGerald

553 Haverstraw Rd.
Suffern,    NY    10901
(914) 3574171

(6:00pm 10:00pm Eastern Time) 

Copyright (c) 1994 by Gary FitzGerald.    All rights reserved. 

TABLE OF CONTENTS
 1. Installation
 2. Registration Form
 3. Software Support - In case of difficulty
 4. Definition of Shareware
 5. Disclaimer - Agreement

=============
INSTALLATION
=============

The disk contains    COMPDICT.HLP, README.TXT and REGISTER.TXT
To print this file type:        COPY A:\README.TXT PRN
To copy the files from the disk to your Windows directory on the hard disk type:
        COPY A:\*.* C:\WINDOWS    (for your A disk drive or B: for your B drive)
This is to make the program run faster.
In the Windows Program Manager open the group in which you want
the Computer Dictionary to appear (i.e.: Startup) and select:

File, New, New Program Item, OK
Computer Dictionary Type in the title and press TAB
WINHELP COMPDICT.HLP Type in the command line, click OK

Double click the questionmark icon to start the program.

To have this readme file available, open the group in which
you want the icon to appear and in the Program Manager select:

File, New, New Program Item, OK
Computer Dictionary Readme Type in the title and press TAB
NOTEPAD README.TXT Type in the command line, press OK

Follow the same procedure to view the registration form:
NOTEPAD REGISTER.TXT        

 In Notepad, select File/Print to print a copy of the    registration form for mailing.



===================
REGISTRATION FORM    -    Click here to view registration form
===================

==========================================
SOFTWARE SUPPORT - IN CASE OF DIFFICULTY
==========================================

In case of difficulty installing this program:    Place the disk you received in drive A (or B).
To start Windows by type WIN at the DOS command prompt.    When the Program 
Manager screen appears use your mouse to select from the main menu: File, Run (or 
keystrokes ALT, F, R) and type:

          WINHELP A:\COMPDICT.HLP    (If the disk is in the B drive, substitute B: for A:)
(If the disk you received has the files compressed, follow the vendor's instructions for 
expanding the files.    Once expanded, replace the A: in the command line above with 
the path (ex: C:\CDICT) where you located the expanded files.)

Press Enter or click OK.    The Computer Dictionary will start.    This means you are 
running the program from the disk.    The disk is not damaged.    You should try the 
installation procedure above again.    If the program does not start the disk or files you 
have may have been damaged.    Contact your distributor for a replacement.

Registered users are supported by the author for a period of three months from the date
of registration.    Contact Gary FitzGerald by mail at 553 Haverstraw Rd, Suffern, NY 
10901 or phone at (914) 3574171.    The best time to call is 6:00 pm to 10:00 pm. 
Eastern Time.    Support by phone is limited to 30 minutes of total connect time.    
Support may be provided for a fee after this initial period has elapsed.

Gary FitzGerald is a member of the Association of Shareware Professionals (ASP).    
ASP wants to make sure that the shareware principle works for you. If you are unable to
resolve a sharewarerelated problem with an ASP member by contacting the member 
directly, ASP may be able to help. The ASP Ombudsman can help you resolve a dispute
or problem with an ASP member, but does not provide technical support for members' 
products.    Please write to the ASP Ombudsman at 545 Grover Road, Muskegon,
MI 494429427 USA, FAX 6167882765 or send a CompuServe message via 
CompuServe Mail to ASP Ombudsman 70007,3536. 

=========================
DEFINITION OF SHAREWARE
=========================

Shareware distribution gives users a chance to try software before buying it.    If you try 



a Shareware program and continue using it, you are expected to register it.    Individual 
programs differ on details some request registration while others require it, some 
specify a maximum trial period.    With registration, you get anything from the simple 
right to continue using the software to an updated program with printed manual.    
Copyright laws apply to both Shareware and commercial software, and the copyright 
holder retains all rights, with a few specific exceptions as stated below.    Shareware 
authors are accomplished programmers, just like commercial authors, and the programs
are of comparable quality. (In both cases, there are good programs and bad ones!)    
The main difference is in the method of distribution.    The author specifically grants the 
right to copy and distribute the software, either to all and sundry or to a specific group.    
For example, some authors require written permission before a commercial disk vendor 
may copy their Shareware.

Shareware is a distribution method, not a type of software.    You should find software 
that suits your needs and pocketbook, whether it's commercial or Shareware.    The 
Shareware system makes fitting your needs easier, because you can try before you buy.
And because the overhead is low, prices are low also.    Shareware has the ultimate 
moneyback guarantee if you don't use the product, you don't pay for it.

========================
DISCLAIMER - AGREEMENT
========================

Users of the Computer Dictionary must accept this disclaimer of warranty: "Computer 
Dictionary is supplied as is.    The author disclaims all warranties, expressed or implied, 
including, without limitation, the warranties of merchantability and of fitness for any 
purpose.    The author assumes no liability for damages, direct or consequential, which 
may result from the use of the Computer Dictionary."

Computer Dictionary is a "shareware program" and is provided at no charge to the user 
for evaluation.    Feel free to share it with your friends, but please do not give it away 
altered or as part of another system.    The essence of "usersupported" software is to 
provide personal computer users with quality software without high prices, and yet to 
provide incentive for programmers to continue to develop new products.    If you find
this program useful and find that you are using the Computer Dictionary and continue to
use the Computer Dictionary after a reasonable trial period, you must make a 
registration
payment of $5.00 to Gary FitzGerald.    The $5.00 registration fee will license one copy 
for use on any one computer at any one time.    You must treat this software just like a 
book.    An example is that this software may be used by any number of people and may
be freely moved from one computer location to another, so long as there is no possibility
of it being used at one location while it's being used at another. Just as a book cannot 
be read by two different persons at the same time.
Commercial users of the Computer Dictionary must register and pay for their copies of 
the Computer Dictionary within 30 days of first use or their license is withdrawn.      



SiteLicense arrangements may be made by contacting Gary FitzGerald.

Anyone distributing the Computer Dictionary for any kind of remuneration must first 
contact Gary FitzGerald at the address above for authorization. This authorization will 
be automatically granted to distributors recognized by the (ASP) as adhering to its 
guidelines for shareware distributors, and such distributors may begin offering the 
Computer Dictionary immediately. (However Gary FitzGerald must still be advised so 
that the distributor can be kept uptodate with the latest version of the Computer 
Dictionary.)    You are encouraged to pass a copy of the Computer Dictionary along to 
your friends for evaluation.    Please encourage them to register their copy if they find 
that they can use it.      All registered users will receive a copy of the latest version of the 
Computer Dictionary system.



*

The asterisk is a wildcard that represents a whole word or a group of characters.    The wildcard 
"*.*" refers to all files, "*.TXT" refers to all files with a .TXT extension, "GF*.*" refers to all files 
whose names begin with GF.    This symbol is also used in a numeric formula to signify a 
multiplication between the two numbers on either side of it.



@ function

The "at sign" is the symbol used for the "at function."    These are mathematical functions which 
are available for use in spreadsheet programs.    For example, the function "@sum" will add a 
group of spreadsheet cells and display the total.



@

The "at sign" symbol tells DOS to "execute the command that follows, but do not display the 
instruction itself on the screen."    (This applies to that one line only.)



\

The backslash (\) character is used to describe directories for the operating system on a 
computer. The backslash character alone describes the root directory of the current drive, disk or
partition.    For example, to change to the root directory of the current drive, type "cd \" which tells
the operating system to change directories to the root directory.    The backslash character is also
used to separate the drives, directories and file names of a path name or DOS command.    For 
example, "c:\windows\win" tells the operating system to go to the "c:" drive, go to the "windows" 
directory and execute the file named "win."    This command typically starts the Windows 
operating system.



^

The carat symbol (^) is used in some menu systems to designate the use of the Control (CTRL) 
key.    For example, if a menu shows "^S", to activate that menu item, press and hold the Control 
(CTRL) key on the keyboard and then press the letter "S."



:

A letter followed by a colon instructs DOS to change the current drive to the drive letter specified.
For example, "a:" changes to the A drive or "c:" changes to the C drive.



/

The forward slash (/) character is used with DOS commands to add switches or options to the 
command to perform additional functions.    For example, the "/s" switch added to the DOS 
BACKUP command means that you want to include all subdirectories.    The forward slash is also
used in some spreadsheet programs to gain access to the main menu of the program.



%

The percent symbol is used to call a command line parameter (%0 to %9) or an environment 
variable (%variable%) in a batch file.    (See replaceable parameters and the SET command.)



|

This is called the pipe character and it is normally used to add another command to a primary 
command.    This is often seen with the MORE command in DOS to have the output of the 
original command displayed one screen at a time and then pause for user input before 
displaying the next screen.    Examples are "DIR |MORE" and "TYPE xxx |MORE."



286

This number refers to a computer that is equipped with a 80286 central processing unit (CPU).



386

This number refers to a computer that is equipped with a 80386 central processing unit (CPU).



386 enhanced mode

A mode in which Windows runs to access the virtual memory capabilities of the 80386 processor.
In this mode, Windows appears to use more memory than is physically available and provides 
multitasking for non-Windows applications.    This mode allows non-Windows applications to run 
in the background and in a window.    See also standard mode.



486

This number refers to a computer that is equipped with a 80486 central processing unit (CPU).



80286

This is the designation number for the Intel central processing unit (CPU) introduced in 1982 for 
personal computers.    This CPU has a 16 bit internal bus and it typically runs at 8MHz clock 
speed.    The IBM PC/AT computer is based on this CPU.



80287

This is the designation number for the math coprocessor chip that works with the 80286 CPU.



80386

This is the designation number for the Intel central processing unit (CPU) introduced in 1985 for 
personal computers.    This CPU (typically called the DX version) has a 32 bit internal bus and it 
typically runs at 16 to 33MHz clock speed.    Intel introduced an SX version of this 
microprocessor in 1988.    The SX version has the same 32 bit CPU, but it has a 16 bit bus path.  
The SX version computer runs slower because of the smaller communication path from the CPU 
to the rest of the motherboard and peripheral devices.



80387

This is the designation number for the math coprocessor chip that works with the 80386 CPU.



80486

This is the designation number for the Intel central processing unit (CPU) introduced in 1989 for 
personal computers.    This CPU (typically called the DX version) has a 32 bit internal bus and it 
typically runs at 20 to 33MHz clock speed.    This DX version includes a math coprocessor within 
the CPU chip.    The math coprocessor is a circuit that works with the CPU to speed up complex 
calculations in graphics and number intensive programs and it was previously offered as a 
separate chip at additional cost.    The SX version of the 486 CPU was introduced in 1991 and it 
does not have a math coprocessor.    The 486DX2 was introduced in 1992 and this is a 486DX 
CPU that includes a clock doubler which doubles the running speed of the CPU.



8080

This is the designation number for the Intel central processing unit (CPU) introduced in 1974 for 
personal computers.    This CPU has an 8 bit internal bus and it typically runs at 2MHz clock 
speed.



8086

This is the designation number for the Intel central processing unit (CPU) introduced in 1978 for 
personal computers.    This CPU has a 16 bit internal bus and it typically runs at 5MHz clock 
speed.



8088

This is the designation number for the Intel central processing unit (CPU) introduced in 1979 for 
personal computers.    This CPU has a 16 bit internal bus and it typically runs at 8MHz clock 
speed.    The IBM PC/XT computer is based on this CPU.



About

This choice in the Help Menu displays a dialog box that gives the software name, version 
number and possibly user or computer system information.



AC

An acronym for Access Control. 



access method

The set of rules by which networks arbitrate their use.



Access Control (AC)

On Token Ring networks, this is a byte of information in memory that contains the token indicator
and frame priority.



access time

The amount of time required for a storage device to begin delivering data after the computer 
sends a data request.



accounting management

Reports costs for network resources requested by users and groups.    It is also one of five 
categories of network management defined by the ISO.



active device

A device that supplies current for the loop in a network.



active icon

The icon that you are currently using or that is currently selected.    Only one window or icon can 
be active at a time.    If an icon is active, its label changes color.    Windows or icons on the 
desktop that are not selected are inactive.



active window

The window in which you are currently working.    The window that you are currently using or that
is currently selected.    This window can receive input from the user.    Only one window or icon 
can be active at a time.    If a window is active, its title bar changes color to differentiate it from 
other windows.    If an icon is active, its label changes color.    Windows or icons on the desktop 
that are not selected are inactive.



adapter

A printed circuit board that modifies the system unit (computer) to allow it to operate in a 
particular way.



address

A specific location in a computer's memory that is used to store information.



allocation unit

A cluster or allocation unit is a grouping of disk storage sectors.    These two terms, "cluster" and 
"allocation unit" are used interchangeably and they mean the same thing.    This is the smallest 
amount of disk storage memory that DOS can address.



alphanumeric

Words or codes comprised of alphabetic characters and/or numbers.



ALT key

This key is normally used in combination with some other key on the keyboard.    For example, 
ALT+F4 will close a Windows application.    Used alone in a Windows application, this key 
typically will provide access to the main menu system.



analog

A transmission scheme that continually varies the waveform over an infinite range of voltage.



analog recording

A transfer method that converts data from digital to analog format.



animated icon

This is an icon that appears to move on the computer screen.    The animation is actually 
performed by having the computer display a series of still pictures or images, one after the other. 
The result appears to be a moving picture (like a movie or cartoon.)



animation

This is the act of creating the appearance of motion on a computer screen.    The animation is 
actually performed by having the computer display a series of still pictures or images, one after 
the other.    The result appears to be a moving picture (like a movie or cartoon.)



ANSI character set

The American National Standards Institute 8-bit character set.    It contains 256 characters.



ANSI.SYS

This optional DOS file (if loaded in CONFIG.SYS) defines functions that change display 
graphics, controls cursor movement and reassigns keys.    To have this feature available, a line 
similar to "device=c:\dos\ansi.sys" must be in the CONFIG.SYS file prior to boot up.



API 

An acronym for Application Program Interface.



APPEND

This DOS command allows programs to open data files in specified directories as if they were in 
the current directory.    The specified directories are called appended directories because, for the 
sake of opening data files, they can be found as if they were appended to the current directory.



application

A computer program used for a particular kind of work.    Also called a program or software.



application icon

A graphic that represents an application.



application program

Any software program such as a word processor, spreadsheet, or database manager.



Application Program Interface (API)

A set of programming functions and routines that provides access between protocol layers, such 
as between an application and network services.



application software

Computer programs used to perform specific tasks such as word processing, data management,
and spreadsheets.



archive

A backup of data or a program used in the event that    the original data or program is destroyed.



archive attribute

A file characteristic that indicates whether the file has been changed since it was last backed up. 
This attribute is usually set when the file is created or modified, and then cleared when the file is 
backed up.



ARCnet

A 2.5 megabit per second baseband, token passing network designed by Datapoint Corporation 
that supports up to 255 nodes.



Arrange

This choice in the Window Menu causes all of the icons of the minimized windows to be lined up 
neatly at the bottom of the main window.



arrow keys

The keys you use to navigate around your screen.    Each key is marked with an arrow and is 
named for the direction in which it moves the cursor.    Also called direction keys or cursor keys.



ASCE

An acronym for Association Control Service Element, an application level protocol.



ASCII

An acronym for American Standard Code for Information Interchange.    This code is used by 
computers to process numbers and words.



ASCII character set

The American Standard Code for Information Interchange 7-bit character set.    It consists of the 
first 128 characters of the ANSI character set.    The ASCII character set is the most universal 
character coding set.



assembly language

A low-level computer programming language noted for producing small sized, fast running 
programs.



associate

To identify a file name extension as "belonging" to a certain application.    See also document 
files.



Association Control Service Element (ASCE)

An application level protocol.



asterisk (*)

The asterisk is a wildcard that represents a whole word or a group of characters.    The wildcard 
"*.*" refers to all files, "*.TXT" refers to all files with a .TXT extension, "GF*.*" refers to all files 
whose names begin with GF.    This symbol is also used in a numeric formula to signify a 
multiplication between the two numbers on either side of it.



asynchronous transmission

A data transmission technique controlled by start and stop bits at each end of a character and 
characterized by an undetermined time interval between characters.



at sign

The "at sign" symbol tells DOS to "execute the command that follows, but do not display the 
instruction itself on the screen."    (This applies to that one line only.)



ATTRIB

A DOS command that displays or changes file attributes.    This command sets or    removes 
(clears) the archive, read only, system, or hidden attributes of a file.



attribute

A characteristic or property of a file.    Information about a file that indicates whether the file is 
read only, system, hidden or whether it has been changed since it was last backed up.    Also 
called a flag.



audio file

A file used for digital audio sounds on a waveform device.



audit trails

A record of events on a network, including when users requested specific resources.



AUTOEXEC.BAT

A batch file whose main purpose is to process commands that set up the operating system for 
DOS.    It is automatically carried out whenever the computer is started or restarted.    The file 
contains basic start up commands that help configure the system.



Available Space

The space that is available for more storage.    This number represents the total space available 
for use based on the number of clusters that are not used.



backbone

Cable on which two or more stations or networks may be attached.



background

The conditions under which a low-priority program runs when high-priority programs are not 
using the system resources.    In the background, one program step is run at a time.    Also, the 
area behind and outside the active window, including the desktop and any other application 
windows or icons.



backslash (\)

The backslash (\) character is used to describe directories for the operating system on a 
computer.    The backslash character alone describes the root directory of the current drive, disk 
or partition.    For example, to change to the root directory of the current drive, type "cd \" which 
tells the operating system to change directories to the root directory.    The backslash character is
also used to separate the drives, directories and file names of a path name or DOS command.    
For example, "c:\windows\win" tells the operating system to go to the "c:" drive, go to the 
"windows" directory and execute the file named "win."    This command typically starts the 
Windows operating system.



BACKSPACE key

This key will cause the software to delete the letter immediately to the left of the cursor or if text 
has been highlighted (selected), the entire block of highlighted text will be deleted.



backup

Off line copies of data for protection against system failures.    A duplicate or extra copy of the 
installation software disks made as replacement copy for an original.    A copy of data or a 
program used in the event that the original data or program is destroyed.



BACKUP

This DOS command backs up one or more files from one disk onto another.    This command is 
used to back up entire disk partitions or whole directories but it will not back up system files.    
See the RESTORE command to retrieve backed up files.



bandwidth

This represents the difference between the highest and lowest frequencies available for signals 
and is used to indicate the transmission capacity in Hertz.



baseband

A network in which the entire bandwidth of the transmission medium is used by a single digital 
signal.    Unlike broadband, no modulation techniques are used.



BASIC

An acronym for Beginner's All-Purpose Symbolic Instruction Code.    An interpreter programming 
language that is usually packaged along with a computer.    This is an easily learned, high-level 
computer programming language that is taught in high school.



BAT

The file extension denoting a batch file (see batch file below). 



batch file

A file that contains a series of commands to be processed sequentially.    This type of file usually 
has a .BAT file extension.    When this text file is run, the operating system carries out the 
commands in the file as if you had typed them at the command prompt.



baud

Measurement of signaling speed indicating line changes per second, where line changes can 
represent one or more bits.    A measure of data transfer speed.    Only for line changes 
representing a single bit, baud is equal to bits per second.    Common baud rates in 
telecommunicating are 300, 1200, 2400, or 9600.



baud rate

A number representing the speed at which information travels over a communication line and/or 
through a COM serial port.



BBS

An acronym for bulletin board system.



bi-directional printing

Printing in which the print head is printing in both directions (left to right then right to left).    This 
operation usually applies to dot matrix printers and is faster but sometimes has poorer quality 
than uni-directional printing.



binary

This is a counting system that uses only two digits "0" and "1."    We are all used to the decimal 
counting system that uses ten digits (0 to 9).    The binary system is used in computers because 
it is easier for the machine to understand the binary instructions.    Since the memory systems of 
a computer consist of a series of switches, a binary "0" means that the switch is off and a binary 
"1" means that the switch is on.



binary code

A combination of 0's and 1's used to represent letters, numbers and symbols in a computer's 
memory.



binary digit

A digit in the binary notation system commonly abbreviated "bit." 



binary file

A file containing information that is in machine readable form.    It can be read only by an 
application or the operating system.



binary transfer

A method for transferring any kind of file between two computers via modem.    Text files may be 
transferred by this method or the text transfer method at the user's option.



BIOS

An acronym for Basic Input/Output System.    Provides fundamental services required for the 
operation of a computer.    These routines are generally stored in Read Only Memory (ROM) and
they control basic hardware operations such as interactions with diskette drives, hard disk drives
and the keyboard.



bit

A contraction for binary digit.    The smallest unit of computer information.    Like a switch, this unit
is on or off - either 1 or 0.



bitmap

A representation of an image by an array of bits.    The image is stored as a pattern of dots.



bitmap graphics

A form of graphics in an area of computer memory that can be displayed as an image.



bits per second (BPS)

A unit of transmission.    Also called baud rate.



bitwise

A bitwise operation is an operation that is performed on bits, not decimal numbers. 



block command

Section of text in a word processor document or cells in a spreadsheet or records in a database 
that you highlight is called a block.    Once highlighted, you can perform an operation on the 
entire block at the same time.    The command issued for the entire block is called a block 
command.    Common block commands are cut, copy, delete, move, etc.



BMP

This is a file name extension (.BMP) used for a bitmapped graphic file format created by paint 
programs, like PC Paintbrush, or some screen capture programs.    This is the most common 
form of graphics format used by Windows.



BNC

A standardized connector used for networks with Thinnet and coaxial cable.



board

A printed circuit board with an interconnected assortment of electronic components or integrated 
circuit chips that perform some useful operation.    Some features are added to a computer by 
adding a card into an extra card slot in the computer's motherboard.    Also called a card or circuit
board.



bookmark

A menu choice that is used to save your place in the document that you are viewing, by marking 
the topic that is displayed.



boot 

To start or restart your computer and load the operating system from your hard disk or floppy 
disk.



boot disk

The disk from which the operating system is loaded when you start your computer (usually 
placed in drive A).



Boot PROM

An acronym for Boot Programmable Read Only Memory.



Boot Programmable Read Only Memory (Boot PROM)

A processor chip usually mounted on the network interface card that enables a personal 
computer to load the operating system from the network.



bootable disk

A system disk from which the operating system is loaded when you start your computer (usually 
placed in drive A).



bootstrap

A read only memory (ROM) program used for starting the computer and getting it ready for use.



border

A visual indicator of a window's boundaries.



BPS 

An abbreviation for bits per second.



branch

A segment of a directory tree, including a directory and any subdirectories within it.



BREAK

This is a DOS command that sets or clears extended CTRL+C checking.    Typically,    DOS 
checks for CTRL+C only while it reads from the keyboard or writes to the screen or printer.    If 
you set BREAK=ON, you extend CTRL+C checking to other functions such as disk operations.    
This command can be used in CONFIG.SYS.



bridge

A device operating at the data link layer to connect local or wide-area networks that use the 
same protocol.



broadband

A network in which the bandwidth can be shared by multiple simultaneous signals that are 
encoded with radio frequency modulation.



broadcast

The address for all nodes in a network or the message sent to all nodes.    In Windows    
programming, this is a message that is sent to all open windows.    For example, when the user 
wants to close the Windows operating system, a message is sent to all open windows asking if 
there is any unsaved data and if it is OK to close.    If OK, the window is closed.    If not, a 
message box is displayed to the user prompting him to save the data in a certain application.



brouter

A device that can route specific protocols and bridge others, thus combining the capabilities of 
bridges and routers.



browse

To look through files and directories.    Some dialog boxes have a Browse button which allows 
you to look for the file you want.



buffer

A RAM memory storage location that is used to temporarily hold data during communication 
between two devices.    A temporary storage location that provides uninterrupted data flow 
between devices, such as keyboards and processors, or processors and printers, until the data 
from one can be accepted by the other.    A device that temporarily holds information in memory.   
This information is lost when the buffer is turned off.    Buffers are generally used between a 
computer and a printer so that the computer will not be tied up the entire time printing is taking 
place.



BUFFERS

This is a DOS command that allocates memory for a specified number of disk buffers when your 
system starts.    DOS uses buffers to hold data during read and write operations.



bug

An error, defect or problem.    A software bug is an error in a program and a hardware bug is a 
malfunction in the equipment.



bulletin board system

Commonly referred to as a BBS (bulletin board system) that users can access through the use of
their own computer with a modem and a telephone line.    The user "calls" the BBS by having his 
computer dial the telephone number.    Then one of the computers at the BBS answers the call 
and it connects itself to the calling user.    The calling user may then perform some action like 
view e-mail, chat with other users, download files, read information, etc.



bus

The internal communication path from the CPU to the rest of the motherboard and peripheral 
devices.    Some "SX" models have a bus path of smaller capability than the main CPU.    Also 
called bus path.



bus topology

A network topology in which nodes are connected to a single cable with terminators at each end.



button

An area on the screen used to request or initiate an action.



byte

A group of eight binary digits (or bits) that can represent a number or a character.



C

A low level programming language for computers.    This is the most popular language and it is 
used in graduate schools.



C++

This is an enhanced version of the C programming language.



cache

Memory location set aside to store frequently accessed data for improved system performance.   
This is a high speed buffer RAM memory used between the central processor and main memory.
It is used to reduce hard disk access time by storing the commands needed to operate the hard 
disk.    Sometimes the cache also stores the data to be transferred.



CALL

A DOS command that calls (executes) one batch program from within another batch program 
without causing the parent batch program to stop.    Batch parameters can be added after the file
name to pass any information you want to the called batch program.    This command is only 
useful in batch programs.



capacity 

The storage size of the disk in megabytes.



CAPS LOCK key

This key toggles the caps lock function as indicated by the light on the keyboard.    With the caps 
lock on, any letter typed will be a capital letter, but all other keys will be unchanged.    With the 
caps lock off, all letters will be lower case unless the SHIFT key is pressed.



carat

The carat symbol (^) is used in some menu systems to designate the use of the Control (CTRL) 
key.    For example, if a menu shows "^S", to activate that menu item, press and hold the Control 
(CTRL) key on the keyboard and then press the letter "S."



card

A printed circuit board with an interconnected assortment of electronic components or integrated 
circuit chips that perform some useful operation.    Some features are added to a computer by 
adding a card into an extra card slot in the computer's motherboard.    Also called a board or 
printed circuit board.



Carrier Sense Multiple Access with Collision Avoidance (CSMA/CA)

Network access method using contention similar to CSMA/CD used by LocalTalk networks.    
Unlike CSMA/CD, in this method, the sending node requests permission to send from the 
intended receiving node.    If the receiving node responds with a "clear to send" signal, 
transmission begins.



Carrier Sense Multiple Access with Collision Detection (CSMA/CD)

Network access method in which nodes contend for the right to send data.    If two or more nodes
attempt to transmit at the same time, they abort their transmission until a random time period of 
microseconds has past and then attempt to retransmit at different times.



cartridge font

A font contained in a cartridge that physically plugs into your printer.    See font cartridge.



Cascade

A choice in the Window Menu that arranges the secondary windows so that each window is 
offset on two sides from the window it overlaps so that each title bar is visible.    The windows 
appear to be stacked, one behind the other.



cascaded menu

A menu that appears when the arrow to the right of a cascading choice is selected. It contains a 
set of choices that are related to the cascading choice.    Cascaded menus are used to reduce 
the length of a menu.



cascading choice

A menu choice that has an arrow to the right of it.    If this arrow is selected, a cascaded menu 
appears.



case

The metal and plastic container that holds the main components of a personal computer.



case sensitive

A condition in which entries for an entry field must conform to a specific lowercase, uppercase or
mixed-case format in order to be valid.



CD - CHDIR

"Change Directory" - Changes the current directory.    CD without a parameter displays the name 
of the current directory.    The parameter following the command tells DOS where you want to go.
You may include a drive letter and colon (:) to change drives as well as directories.    "CD \" 
changes to the root directory of the current drive (it is always best to start at the root directory or 
change through the root directory).    To change to a subdirectory named "GARY", type "CD \", 
then "CD GARY".



CD-ROM

An acronym for Compact Disc Read Only Memory.    This is a storage device for high capacity 
optically read information.



Central Processing Unit (CPU)

The electronic nerve center of a computer which controls the processing done by the computer.   
The Central Processing Unit carries on all computer operations.    The Intel 80286, 80386, 
80486, etc., chips are CPU's.



CGA

An acronym for Color Graphics Adapter.    Medium resolution IBM graphics standard capable of
displaying 640 x 200 pixels in 2 colors, or 320 x 200 pixels in 4 colors.



CGM

This is the file name extension (.CGM) and acronym for Computer Graphics Metafile which is a 
type of vector graphic that can be produced by drawing or spreadsheet programs, such as 
Harvard Graphics, Freelance Graphics and Corel Draw.    This format was created by the 
American National Standards Institute, Inc. (ANSI) to provide a standard for graphical 
information exchange and is widely supported.



character

A letter, digit or other symbol that is used as part of the organization, control or representation of 
data.



character set

A group of letters, numbers and symbols that have some common relationship.



check box

A square box with associated text that represents one choice in a set of multiple choices. When 
you select a choice, a check mark or 'X' appears in the box to indicate that the choice is active.



check mark

A symbol that shows that a choice is currently active.    This symbol is used in menus and check 
boxes.



chip

An integrated circuit etched on the surface of a tiny wafer of silicon and enclosed in a plastic or 
ceramic package.    Pins extend from this package for connection to other electronic circuits.



chip set

An integrated circuit or a set of integrated circuits that provide hardware support for a related set 
of functions, such as generation of video.



CHKDSK

A DOS command that checks a disk and displays a status report on the screen which shows the 
total disk space, space available, allocation unit size and more.    The status report also shows 
logical errors found, if any, and can fix them.



choice

Any item that you can select.



CHOICE

A DOS command that prompts the user to make a choice in a batch program.    It displays a 
specified prompt and pauses for the user to choose from among a specified set of keys.    This 
command is only useful in batch programs.



choose

To pick an item that begins an action. 



circuit

An interconnected assortment of electronic components or integrated circuit chips that perform 
some useful operation.



clear

To turn off an option.



click

To press and release the select button on a pointing device without moving the pointer off the 
choice.    Usually, this means to press the left mouse button once.



client

A node that requests network services from a server.



client application

An application whose documents can accept linked or embedded objects.



client-server computing

A technique with which processing can be distributed between nodes requesting information 
(clients) and those maintaining data (servers).



clipboard

An area of memory that temporarily holds data being passed from one program to another or 
from one place to another in the same program.    Data is placed on the clipboard by selecting a 
menu item or clicking on a toolbar button.



clock

An electronic circuit that emits a regulated sequence of electrical pulses synchronizing the 
operation of the circuits in a computer.



clock speed

This is the speed at which the computer's internal clock is running.    The higher the clock speed, 
the faster the computer will operate.    Clock speed is usually measured in megahertz (MHz.)



clone

In the strict definition, this term is used to describe an item that is an exact copy of an original 
item.    In the computer world, this term is used to describe a computer that operates exactly like 
the IBM microcomputer even though it may be constructed and look physically different.    Thus, 
the IBM clone is a computer that will function just like the original and run all of the same 
software programs as the original, but it is made by another company and it doesn't look the 
same as an IBM.    Also called a compatible.



close

This choice ends highlighted programs, objects and their associated windows.



Close

This choice in the File Menu will close the current document in the application.    It only closes 
the document and not the entire application.    If you did not save any changes made, a dialog 
box will usually remind you that changes have been made and ask you if you wish to save them.



CLS

A DOS command that clears the screen of all previous messages.    The cleared screen shows 
only the command prompt and cursor.



cluster

A cluster or allocation unit is a grouping of disk storage sectors.    These two terms "cluster" and 
"allocation unit" are used interchangeably, and they mean the same thing.    This is the smallest 
amount of disk storage memory that DOS can address.



CMOS

An acronym, pronounced "sea moss" and stands for Complementary Metal-Oxide 
Semiconductor.    This MOS chip design is used because it costs less, consumes less electricity 
and can hold more circuitry in the chip than other designs.    A CMOS chip is used with battery 
backup to store the BIOS settings in a personal computer which tell the computer how to start 
itself when power is first turned on (Typically 3vDC voltage level).    The CMOS runs the 
computer's internal clock and calendar for the time and date.



coaxial cable

Data transmission medium with a single wire conductor insulated from EMI/RFI (Electromagnetic
Interference / Radio Frequency Interference) by a conductive shield around the single wire.    The
conductive shield is usually connected to earth ground.



COBOL

This is an acronym for Common Business Oriented Language which is a high-level programming
language.    It is typically used for business applications.



code

A method used to represent characters, numbers and symbols with binary numbers.



cold boot

A computer start up sequence which sets all the registers to their initial conditions.    A cold boot 
is accomplished by turning power on.



collapse

To "hide" subdirectories below a selected directory in a file manager program.



colon (:)

A letter followed by a colon instructs DOS to change the current drive to the drive letter specified.
For example, "a:" changes to the A drive or "c:" changes to the C drive.



color scheme

A predefined combination of colors used for screen elements.    You can choose a color scheme 
or create your own.



COM

The file extension denoting a command file.    Command files are also files that you can run.



COM port

A serial port.    A 25 or 9 pin I/O port on the back of a computer in which data is transmitted and 
received serially (COM1 to COM4).    It connects to a cable with a 25 or 9 hole connector 
(RS232).



command

A word or phrase that you choose or type in order to carry out an action.    A character, word or 
string of words that tells a computer to do something.



COMMAND

A DOS command that starts a new instance of the MS-DOS command interpreter, 
COMMAND.COM.    This is the program that displays the command prompt where you type 
commands.    Use the EXIT command to stop the new command interpreter and return control to 
the old one.



command button

An area on the screen used to request or initiate an action.



command line

The instructions you type after the prompt to run an application.



command prompt

A displayed symbol that indicates where you enter commands.



common carrier

A licensed, private utility company that supplies data and voice communication services.



communication program

A program used to direct a modem to send and receive data over the telephone lines.



communication settings

Settings that specify how information is transferred from your computer to a device like a modem
or printer.



COMP

The DOS command "Compare", compares the contents of two files or sets of files byte by byte.



compact disc

A disc, usually 4.75 inches in diameter, with information stored in the form of pits along a spiral 
track.    The information is decoded by a compact disc player and interpreted as digital audio 
data, programs, graphics, etc., which most computers can process.    The disc is    read optically 
by means of a laser.



compatible

In the computer world, this term is used to describe a computer that operates exactly like the 
IBM microcomputer even though it may be constructed and look physically different.    Thus, the 
IBM compatible is a computer that will function just like the original and run all of the same 
software programs as the original, but it is made by another company and it doesn't look the 
same as an IBM.    Also called a clone.



concurrency control

Rules that regulate data access to multiple users on a database server.



condensed printing

Printing in which each character is approximately 60% of the width of standard characters.    This
is useful for fitting wide tables or spreadsheets onto paper.



CONFIG.SYS

This file contains statements that set up the system configuration each time you start or restart 
the operating system.    The commands in this file enable or disable system features, set limits 
on resources and extend the operating system functionality by loading device drivers.    The 
operating system adds this file to the root directory during installation. 



configuration

The manner in which hardware and software of an information processing system are organized 
and interconnected.



configure

To describe to a system the devices, optional features and programs installed on the system.



confirmation message

A message that appears after you specify certain actions, prompting you to confirm that you 
want to continue with the action or to specify that you want to cancel it.



container

An object that holds other objects.    A group in Windows and a folder in OS/2 are examples of 
container objects.



contention

Network access method in which nodes compete for transmission by sending signals at will.



Contents

This choice in the Help Menu starts the help system for the program and load the table of 
contents for the user to select the topic of interest.



context sensitive help

A feature of many programs wherein pressing the hot key (F1) or selecting the menu choice 
brings up the assistance and information that pertains to the portion of the program that is 
currently active or the task that is currently being performed.



continuous paper (continuous feed paper)

Paper that has sprocket-feed holes on each side and is perforated between pages.    Also called 
fanfold paper or tractor paper, it is supplied in a folded stack.



control code

Special codes used to control printer functions such as font, condensed printing, carriage return, 
etc.



control menu

A menu that contains commands you can use to manipulate the window.    Application icons and 
some dialog boxes also have a control menu.    To open the control menu, click the application 
icon or the upper left corner of the window.    Also called a system menu.



controller

A device that coordinates and controls the operation of one or more input/output devices and 
synchronizes the operation of such devices with the operation of the system as a whole.



conventional memory

Random Access Memory (RAM) that begins with address zero and extends to the lowest 
address in the video display region (640K). This is the first 640KB of RAM memory in your 
computer.    The operating system uses this memory to run applications.    Conventional memory 
is available on all PC's.    Also called DOS memory or low DOS memory.



copy

To make a reproduction of an object in a new location.    To put a copy of the selected text or item
onto the clipboard so that you can transfer it to another location.



Copy

This choice in the Edit Menu will put a copy of the selected text or graphics item onto the 
clipboard so that you can transfer it to another location.



COPY

This DOS command copies one or more files from one disk or directory to another.    This 
command also allows you to rename a file, overwrite a file with the same name, combine two or 
more files and use wildcards.    To copy all of a directory's files and subdirectories, you should 
use the XCOPY command.



copy protection

Instructions written into a software program which are added to prevent the software from being 
copied.    Also, a feature of a floppy disk casing to prevent writing to that disk.



COUNTRY

A DOS command that enables DOS to use international time, dates, currency, case conversions 
and decimal separators.



CPU

An acronym for Central Processing Unit.



CRC

An acronym for Cyclical Redundancy Check.



CRT

An acronym for Cathode-Ray Tube which is the video display tube of a monitor.



CSMA/CA

An acronym for Carrier Sense Multiple Access with Collision Avoidance.



CSMA/CD

An acronym for Carrier Sense Multiple Access with Collision Detection. 



CTRL key

This control key is normally used in combination with some other key on the keyboard.    For 
example, CTRL+F4 will close the current document in a Windows application.    



CTRL+ALT+DEL

This special key combination tells the operating system of a computer that the user wants to 
reboot.    This process is a warm reboot because the power remains on the computer.    It is 
normally used to activate changes made to the startup files or when a software program stops 
responding to user input.    The way to use this key combination is to hold the CTRL and ALT 
keys down and press the DEL key.



CTRL+BREAK

This key combination is used in some software programs to stop the execution of a macro or an 
automatic process.



CTRL+C

This keyboard command halts the execution of any batch program.    DOS will display the 
message "Terminate batch job (Y/N)?".    If you press "Y" (for Yes), the batch program ends and 
control returns to the operating system.



current directory

The directory that is active.    This is the first directory in which the operating system looks for 
programs and files.



cursor

The small, blinking line or box on your computer screen which keeps track of the place where 
you are working.



cursor keys

The keys you use to navigate around your screen.    Each key is marked with an arrow and is 
named for the direction in which it moves the cursor.    Also called direction keys or arrow keys.    
Cursor keys also include the PgUp (page up), PgDn (page down), Home and End keys.



cut

A choice in a menu or on a toolbar of a program that removes a selected object, or a part of an 
object, to the clipboard.



Cut

This choice in the Edit Menu removes a selected text or object, or a part of an object, from the 
document and places it on the clipboard so it can be transferred to another location.



cutout

An area of a drawing you select by using a special drawing tool and the mouse.



cut-sheet feeder

An optional, detachable device that automatically feeds single sheets of paper into the printer.



Cyclical Redundancy Check (CRC)

Error checking technique in which bytes at the end of a packet are used by the receiving node to
detect transmission problems.    The bytes represent the result of a calculation performed on the 
data portion of the packet before transmission.    If    the results for the same calculation on the 
received packet are not equal to the transmitted results, the receiving node can request that the 
packet be retransmitted.



DAT

An acronym for Digital Audio Tape. 



data

Any kind of information put into or retrieved from a computer.    The coded representation    of 
information for use in a computer.    Data has certain attributes such as type and length.



Data Communications Equipment (DCE)

A device that establishes, maintains and terminates a data communication session and provides 
encoding or conversion, if necessary.



data compression

A software technique used to increase the amount of data stored on a hard disk.    Data 
compression utilities reduce the space needed to store individual files, thereby increasing the 
number of files that can be stored in a given space.    A compressed file cannot be used until it is 
expanded to its original form.



Data Encryption Standard (DEQ)

U.S. government standard for data encryption.



data file

A file created within an application to store information for use by that application.



data integrity

A measure of accuracy based on error detection.



data processing

The act of sorting, manipulating or rearranging information by a computer.



database

An organized collection of information that can be accessed by a computer.    Also,    describes a 
category of software programs used to organize and manipulate long lists of data such as 
names, addresses, phone numbers, etc.    As you type the list, the software automatically copies 
it onto a disk (unlike most other software that requires you to activate the "Save" feature to write 
to disk).    You can edit the data list and sort it in any order you wish.



database server

A computer that stores data centrally for network users and managers, and often uses client-
server software to distribute the processing of that data between itself and nodes requesting 
information.



DATE

A DOS command that displays and sets the current date on your computer.    After you type this 
command, DOS displays the current date and then asks you for a new date.    Either enter a new
date or just press ENTER if you don't want any changes.



DB-9A

A standardized connector with 9 pins for token ring and serial connections.



DB-15A

A standardized connector with 15 pins for Ethernet transceivers.



DB-25A

A standardized connector with 25 pins for parallel or serial connections.



dBase

A particular database software product (pronounced "dee base") which allows you to invent your 
own database program by using a computer language which resembles Basic but includes extra 
vocabulary for handling databases.



DBLSPACE

This DOS command starts the DoubleSpace program which sets up or configures DoubleSpace 
compressed drives.    DoubleSpace uses data compression to create more free space on a hard 
disk.



DCE

An acronym for Data Communications Equipment.



DD

An abbreviation for Double Density.



DDD

An acronym for Direct Distance Dialing.



DDE

An acronym for Dynamic Data Exchange.



DEBUG

A DOS command that starts Debug, a program testing and editing tool.    Debug can also create 
executable machine code from assembly language statements.



debugging

A procedure of troubleshooting and eliminating errors in software, or malfunctions in hardware.



DECnet

Digital Equipment Corporation's network system and protocols.



decode

The process by which the central processing unit interprets instructions stored in a computer's 
memory.



dedicated server

A node on which applications are limited to maintaining network resources.    No user 
applications are available.



default

An attribute, condition, value or option that is assumed when none is explicitly specified.    A 
value or setting that takes effect when the equipment is turned on, reset or initialized, until 
redefined or changed.



default action

An action that is performed when you press ENTER while at a given place in a program.    This is
intended to be the action that you would most likely want in the given situation.



default button

The command button that is automatically selected.    It usually has some sort of highlight or bold
border for identification.    This is the action that will be taken if you press ENTER.



default choice

A selected choice that a program provides for the initial appearance of an object.



default printer

The printer that is used if you choose the Print command without first specifying which printer 
you want to use.    You can have only one default printer and it should be the one you use most 
often.



default settings

The settings that will be used by an application or operating system unless you specify 
something different.



DEFRAG

A DOS command that reorganizes the files on a disk to optimize the disk for faster disk 
operation.    Files stored in several small pieces in various locations on your disk are said to be 
"fragmented" and take longer to access than files stored in one piece.    The full optimization 
method eliminates all file fragmentation and places all files at the beginning of the disk for faster 
access.



DEL

A DOS command that deletes one or more files in the current directory.    Use wildcards with 
caution.    After a file has been deleted, it can be retrieved with the UNDELETE command only if 
no other files have been created or changed in the meanwhile.    DEL does not remove the files 
themselves, it merely tells DOS that the file space can be used again and the next time DOS 
writes to the disk, it may reuse that file space, thus overwriting the space with new information.



DEL key

This key will cause the software to delete the letter immediately under the cursor box or to the 
right of the cursor or if text has been highlighted (selected), the entire block of highlighted text 
will be deleted.



delimiter

Most commonly used to refer to a character or code that marks the beginning or end of an item 
such as a sentence, paragraph, page, record or field.    Also used in "dynamic delimiter" to refer 
to a character that expands to enclose part of an equation.



DELTREE

A DOS command that deletes a directory and all the files and subdirectories in it.



DES

An acronym for Data Encryption Standard.



deselect

To remove selection highlighting from choices or objects.



desktop

A workspace that fills the entire screen and holds all the objects with which the user can interact 
to perform operations on the system.



desktop computer

A computer small enough to fit on the top of a desk.    Usually, the monitor is placed on top of the 
desktop case and the keyboard is in front of the user.



desktop pattern

A design that appears across the desktop.



desktop publishing

A computer software system which is used to combine text, graphics and formatting to produce 
printed documents such as newsletters, booklets, etc.    With these, you can easily create 
headlines and multiple columns with graphics.    Many of the better word processing programs 
now include many of the desktop publishing commands.



destination directory

The directory to which you intend to copy or move files.



device

A component of the system's hardware configuration that is associated with a computer and 
connected to it.    Another piece of computer hardware equipment.



DEVICE=

This DOS command tells DOS to load the device driver you specify into memory.



device driver

Software that controls how a computer communicates with a device.    A low-level program 
(usually with a .DRV or .SYS file extension) that controls a hardware device such as a monitor, 
printer, hard disk, etc.    Device drivers are usually installed in the CONFIG.SYS file (or maybe in 
AUTOEXEC.BAT) and they become active when the computer is started.



DEVICEHIGH=

A DOS command that loads the device driver specified into the upper    memory area.



diagnostic

An action or program that detects and isolates malfunctions in computer hardware or software.



dialog box

A window that appears temporarily to request information.    Many dialog boxes have options you
must choose before you can continue with the action you have requested. Some dialog boxes 
(called message boxes) give you information.    Usually, you must complete the use of the dialog 
box (called modal dialog boxes) before you can continue with any other action.



DID

An acronym for Direct Inward Dialing. 



digital audio

Audio data that was converted from an analog signal to a digital data stream.    Each number 
represents the intensity of the audio signal at a given point in time.



Digital Audio Tape (DAT)

Medium for storing digital rather than analog data.



digital data

Data in the form of numeric characters.



dimmed

A command in a menu or button that is unavailable or disabled.    Usually, it is shown in light grey.
Also called grayed.



DIP switches

Small (dual in-line package) switches on a printer or other device that control various functions 
and set the default status of the device when it is turned on or initialized.



DIR

A DOS command which displays a list of files and subdirectories in a directory.    This command 
can be followed by "|more" to display only one screen of data at a time and then pause for you to
press a key before displaying the next screen of data.



Direct Distance Dialing (DDD)

A telephone service with which a subscriber can call someone outside the area without requiring 
operator assistance.



Direct Inward Dialing (DID)

A telephone service with which subscribers can have calls within a system routed to a specified 
telephone without switchboard assistance.



direct manipulation

The action of using a mouse or another pointing device to work with objects, rather than through 
menus.



Direct Memory Access (DMA)

Accessing memory in a computer without involving the microprocessor.    Special devices that 
can move information in and out of computer memory without going through the CPU.    Data is 
transferred directly from memory to an intelligent peripheral device.



direction keys

The keys you use to navigate around your screen.    Each key is marked with an arrow and is 
named for the direction in which it moves the cursor.    Also called arrow keys or cursor keys.



directory

A named grouping of files in a file system.    Part of the structure for organizing your files on a 
disk.    A directory can contain files and other directories (called subdirectories).    The first or 
main directory on a disk is called the root directory.



directory name

The name used by a program to identify a directory.    If you are using the file allocation table file 
system, the directory name can be up to eight characters and can be followed by a dot (period) 
and an optional three character extension.



directory name extension (extension)

The up to three optional characters which follow the dot (period) after a directory name.



directory tree

An outline of all the directories and subdirectories on the current drive.    The structure of 
directories and subdirectories on a disk. The directories on the disk are shown as a branching 
structure that resembles a tree.



directory window

A window that displays the directory structure of your disk and the files and subdirectories on it.



disc

A medium for storing information.    This spelling of the word usually pertains to a compact disc 
which is used in a CD-ROM drive.    This type of disc is high capacity and is read optically.    See 
also disk and CD-ROM.



disk

A medium for storing information.    A flat plastic disk coated with a magnetic substance used to 
store information.    Information stored on a disk remains there even when you turn your 
computer off.    Disks are available in various sizes in either removable (floppy) or fixed (hard 
disk) configurations.



disk cache

A portion of memory set aside for temporarily holding disk operation instructions or data to be 
read to or from a disk.



disk drive

A device used for storing and retrieving information on disks.    A motorized device that spins a 
magnetic disk at high speed and contains a sensing device that can read information from and 
write information to a disk.    Also called drive.



disk duplexing

Fault tolerance method in which two disk controllers are used in a single server.



DISKCOMP

A DOS command that compares the contents of two floppy disks.    The floppy disks must be the 
same type and size.    This command compares the disks track by track.



DISKCOPY

A DOS command that copies the contents of one floppy disk to another.    If there is anything on 
the destination disk, this command will destroy its contents.    It will format the destination disk if 
necessary.    The floppy disks must be the same type and size.



diskette

Also called a floppy disk or removable disk used with a computer to store and retrieve 
information.    This type of disk can be removed from the computer as opposed to a hard disk or 
fixed disk which is installed permanently inside the computer.



display

The monitor itself or the information shown on the monitor.



display adapter

Hardware that converts (adapts) video memory to video output.



DISPLAY.SYS

A DOS driver file that supports code-page switching for the console.



dithered color

A color produced by a pattern of differently colored dots that simulate the desired color.    Also 
known as nonsolid color.



DMA

An acronym for Direct Memory Access.



document

Information created by you while using an application.    It is stored as a file on disk.    The 
document is associated with the application you used to create it, as well as any other 
application that may use the same file format.    A document may be a letter, report, spreadsheet,
picture, etc.



document file

A file that is associated with an application.



document window

A window within an application window that displays a document.    There can be more than one 
document window open at a time.



documentation

The operating instructions, application information or servicing information provided with an item 
of computer hardware or software.



DOS

An acronym for Disk Operating System.    This is software that directs the flow of data between 
disk drives and your computer.    Without an operating system, your computer can do nothing.    
This software acts like a "Traffic Cop" to control the flow of information to and from your 
application software.



DOS=

Specifies that MS-DOS is to maintain a link to the upper memory area or is to load part of itself 
into the high memory area (HMA).    In CONFIG.SYS, you must specify DOS=UMB to load 
programs and device drivers into the upper memory area.    DOS=HIGH instructs DOS to load 
part of itself into the high memory area.    In either case, you must first install the HIMEM.SYS 
device driver.



DOS memory

Another term for conventional memory.    This is Random Access Memory (RAM) that begins with
address zero and extends to the lowest address in the video display region (640K).    This is the 
first 640KB of RAM memory in your computer.    The operating system uses this memory to run 
applications.    Conventional memory is available on all PC's.    Also called low DOS memory or 
conventional memory.



DOS Protected Mode Interface (DPMI)

A special specification that allows DOS programs to access memory beyond the first megabyte 
of RAM memory.    DPMI programs are said to run in "protected" mode as opposed to programs 
running in the conventional manner.



DOSKEY

This DOS command starts the Doskey program (a TSR) which edits command lines, recalls MS-
DOS commands, and creates macros.



DOSSHELL

This DOS command starts MS-DOS Shell which is a graphical DOS file manager.    It can be run 
in text mode (dosshell /t), the default, or in graphics mode (dosshell /g).    This program has four 
main areas, a menu bar with a full list of commands, and mouse support.    The drive icons allow 
you to select any available disk drive on your computer.    The directory tree shows the directory 
list on the current drive.    The file list area shows a list of files in the current directory and the 
program list area provides access to common DOS programs and disk utilities.    The areas are 
selected by a mouse or the TAB key.    The menus are accessed by the ALT key. 



dot matrix printer

A printer that forms characters from patterns of closely spaced dots.    A high-speed printing 
device which forms letters and numbers by dots.    The number of pins on the print head 
determine how many dots it takes to form each character.    Also called a pin printer.



Dots Per Inch (DPI)

Designates how many dots per inch a printer can produce.    The higher the DPI, the sharper the 
printed drawing will be.



double click

To press and release the select button on a pointing device twice in rapid succession while the 
pointer is over the intended target of the operation.    This carries out an action such as starting 
an application.



Double Density (DD)

Refers to how information is packed onto a diskette.    Information on double density diskettes is 
packed at twice the density of that on a single density diskette.



double height printing

Printing in which each character is twice as tall as normal.



Double Sided (DS)

Refers to a disk where the storage medium is present on both sides of the disk.



double strike printing

Each character is printed twice in an effort to produce bolder characters.



double width printing

Printing in which each character is twice as wide as normal.



down time

Period when the network is unavailable to users.



download

To copy information from one device to another.    The act of transferring computer files from a 
bulletin board (BBS) to an individual's computer.



download characters

Characters that are defined and stored in the printer by the user.    Also known as user-defined 
characters.



downloaded font

Optional fonts shipped as files and copied onto the hard disk before they can be selected by 
programs.    Also called soft font.



DPI

An acronym for Dots Per Inch.



DPMI

An acronym for DOS Protected Mode Interface.



draft

Also called high speed draft, this print quality is relatively poor but produces the highest printing 
speed possible.



drag

To hold down one of the mouse buttons as you move the mouse.    This operation is used to 
move an item or to draw something in some programs.



drive

A device used for storing and retrieving information on disks.    A motorized device that spins a 
magnetic disk at high speed and contains a sensing device that can read information from and 
write information to a disk.    Also called disk drive.



drive letter

The letter assigned to a drive and followed by a colon (:).    For example, "C:" designates the "C" 
drive.    Note, there is a difference between a logical drive and a physical drive.    A physical drive 
letter is the letter used in the CMOS to identify a physical drive device (a piece of hardware).    A 
logical drive letter is the letter designation used by the operating system to identify a memory 
location on a drive.    For example, it is possible to have a physical "C" drive which has logical 
partitions labeled "C, D and E" and then a physical "D" drive that has partitions "F, G and H."



driver

Software that controls how a computer communicates with a device.    A low-level program 
(usually with a .DRV or .SYS file extension) that controls a hardware device such as a monitor, 
printer, hard disk, etc.    Device drivers are usually installed in the CONFIG.SYS file (or maybe in 
AUTOEXEC.BAT) and they become active when the computer is started. Also called a device 
driver.



DRIVER.SYS

A DOS driver file that creates a logical drive that you can use to refer to a physical disk drive and
specifies parameters for a drive not supported by your hardware.



DRIVPARM

A DOS command that defines parameters for block devices when you start DOS.



DRW

A file extension (.DRW) which designates a vector graphics format created by Micrografx 
programs, such as Designer and Draw.



DS

An abreviation for Double Sided.



dump

To view or print information exactly as it appears in its original form.    In a file dump, you would 
view the contents of a computer file exactly as it is in memory without formatting in some special 
way like database or spreadsheet.    A screen dump usually means to print the information 
exactly as it is displayed on the monitor screen.    This action is usually performed by pressing 
the PRINT SCREEN button on the keyboard.



Dynamic Data Exchange (DDE)

The exchange of data between programs.    Any changes made to the data in the source (server)
application will automatically and dynamically be also changed in the current (client or receiving) 
application.    The data in the current (client or receiving) program is said to be linked to that 
program.



e-mail

An acronym for electronic mail. 



ECHO

A DOS command which turns the command displaying (echoing) feature on or off, or displays a 
message.    When a batch program is run, DOS typically displays (echoes) the batch program's 
commands on the screen.    ECHO OFF turns this feature off and ECHO ON turns it back on.    
Within a batch program, the statement "ECHO hello world" will display the words "hello world" on
the screen.



EDIT

This DOS command starts the MS-DOS Editor, which you can use to create, edit, save and print 
ASCII text files.    This is a full screen simple word processor that you can use to create or 
change DOS batch files.    This program has a main window appearance with a title bar, menu 
bar with a list of commands, a main working area and mouse support.



edit control

A box in a window or dialog box in which you can type information needed to carry out a 
command.    The text box may be blank or may contain text when the window or dialog box is 
opened.    A text box is usually single line, but multi-line text boxes are also used.    A file editor is 
an example of a multi-line text box.    Also called a text box.    (Note: A different definition applies 
in a word processing application.)



Edit Menu

This common main menu choice gives the user access to the clipboard functions of cut, copy 
and paste.    The first choice is usually the "undo" feature.    The menu may contain special 
commands for the OLE    or DDE features if available.    It may also contain search and replace 
features.



editor

A computer program used to create, edit and print text documents.    An application program that 
allows a user to create or edit ASCII files.    Commonly used to create or edit batch files.    Editors
are often called "program editors" because they are used to create source code for computer 
programs.    Editors usually use a standard ASCII format.    Editors are distinguished from word 
processors by having less capability to automatically control the appearance of a document. 



EDLIN

This DOS command is a line oriented text editor for ASCII files.



EGA

An acronym for Enhanced Graphics Adapter.    A high resolution IBM graphics standard 
capable of displaying 640 x 350 pixels in 16 colors.



EGA Monitor

Any monitor capable of displaying both EGA and CGA standard modes.



EGA.SYS

A file that saves and restores the display when Task Swapper is used with an EGA monitor.



EISA

An acronym for Extended Industry Standard Architecture.



Electromagnetic Interference / Radio Frequency Interference (EMI/RFI)

A form of "noise" on data transmission mediums that can reduce data integrity and increase 
transmission errors.



electronic mail (e-mail)

 A method of transmitting information or correspondence between computers.    An application 
with which users can send information to other users with whom they share a data 
communication connection.



embed

To insert information (an object) that was created in one document into another document.    
Most often, the two documents were created with different applications.    The embedded object 
can be edited directly from within the destination document.    To embed, you must be using 
applications that support Object Linking and Embedding (OLE).



embedded object

Information created in one document and inserted into another document.    Embedded objects 
can be edited from within the destination document.



EMI/RFI

An acronym for Electromagnetic Interference / Radio Frequency Interference. 



EMM386.EXE

A file that enables or disables EMM386 expanded memory support.    This is an upper memory 
area manager for computers with an 80386 or higher processor.    This feature simulates 
expanded memory in extended memory and provides access to the upper memory area.



EMS

An acronym for Expanded Memory Specification. 



emulation

The imitation of one device by another.



enable

To make functional.



END key

This key will usually move the cursor to the end of the current line of type.    Used in combination 
with the CTRL or ALT keys, it can move the cursor to another location defined by the software.



End-Of-File mark (EOF)

A symbol or machine equivalent (CTRL+Z) that indicates that the last record of a file has been 
read.



ENTER key

This key is used for different purposes depending on the application that is running at the time.    
On the DOS command line, this key tells DOS to execute the command you just typed.    In a 
word processor, this key inserts a carriage return and line feed, just like the "Return" key on an 
electric typewriter.    In the Windows operating system, this key begins the execution of the 
function represented by the highlighted icon.    In many Windows applications and dialog boxes, 
this key is the same as pressing the "OK" button.    Note: in a Windows application, the TAB key 
is used to move from one data entry field to the next, not the ENTER key.



environment variables

A series of commands placed in the AUTOEXEC.BAT and CONFIG.SYS files that dictate the 
way the operating system is going to run and what external devices it is going to recognize.    
These commands also can be specified as settings of DOS programs and associated with a 
symbolic name.    You use the SET command to define environment variables.



EOF

An acronym for End-Of-File mark.



erase

To remove or clear information stored in a computer's memory.    Same as delete.



ERASE

A DOS command that deletes one or more files in the current directory.    Use wildcards with 
caution.    After a file has been deleted, it can be retrieved with the UNDELETE command only if 
no other files have been created or changed in the meanwhile.    ERASE does not remove the 
files themselves, it merely tells DOS that the file space can be used again and the next time 
DOS writes to the disk, it may reuse that file space, thus overwriting the space with new 
information.



ESC key

This key is used to stop an operation you have begun.    In a Windows application, this key 
performs the same function as pressing the CANCEL button.



Ethernet

A 10 megabits per second baseband, CSMA/CD network originally designed by Xerox 
Corporation.



EtherTalk

AppleTalk protocol governing Ethernet transmissions.    Also the Apple Computer Ethernet 
adapter and drivers.



Ethertype

A two byte code indicating protocol type in an Ethernet packet.



EXE

File extension (.EXE) that denotes an executable file.    Usually a program file.



EXE2BIN

A DOS command that converts .EXE (executable) files to binary format.    It is not useful for 
general users, but is provided as a courtesy to developers.



execute

To perform a computer operation or run an entire computer program.



Exit

This choice in the File Menu allows the user to close the software program completely.    If there 
are any unsaved files open, the program will usually display a dialog box which gives you a 
choice to save the changed information or close without saving.



EXIT

A DOS command that quits (stops) a second (the current) COMMAND.COM program (command
interpreter) and returns control to the program that started it or the first command interpreter.    If 
you "Shell to DOS" from a program, use this command to go back to your original program.    If 
you are in a DOS session under Windows, use this command to close the DOS session and 
return to Windows.



expand

To "show" subdirectories below a selected directory in a file manager program.



EXPAND

A DOS command that decompresses one or more compressed files from the DOS installation 
disks.



expanded memory

This is RAM memory above 1 megabyte that can be used by DOS and some DOS programs in 
addition to conventional memory.



expanded memory emulator

A program that converts extended memory into expanded memory.



Expanded Memory Specification (EMS)

A specification to allow programs to use RAM memory above 1 megabyte in addition to 
conventional memory.    This is sometimes called LIM EMS since the specification was 
developed by Lotus Development, Intel and Microsoft Corporations.    Programs that use EMS 
memory must adhere to the LIM EMS specification.



expansion card

A printed circuit board that plugs into an expansion slot usually on the motherboard in a 
computer.    The expansion card adds some feature or function to the operation of the computer.  
Also called an expansion board.



expansion board

A printed circuit board that plugs into an expansion slot usually on the motherboard in a 
computer.    The expansion board adds some feature or function to the operation of the 
computer.    Also called an expansion card.



expansion slot

Location inside the system unit for the connection of an optional printed circuit board.    The 
specifications for your computer will list the number of expansion slots available for your use.    
An optional feature which you may purchase in the future may include a circuit board which must
be inserted into one of your available expansion slots.



export

To save a document or object from the current application in the file format used by another 
program.



extend selection

To select more than one item.



extended attributes

Additional information that the system or a program associates with a file.



Extended EGA

Offered by proprietary chip sets on non-IBM adapter cards with 640 x 480 resolution or better.



Extended Industry Standard Architecture (EISA)

A computer bus standard compatible with ISA.    This is a 32 bit data path.



extended memory

RAM memory that begins above 1 megabyte is extended memory.



extended memory manager

A program that prevents different applications from using the same part of extended memory at 
the same time.



Extended Memory Specification (XMS)

A special specification to allow programs to use RAM memory above 1 megabyte in addition to 
conventional memory.    Applications work with an extended-memory manager, which makes 
sure that only one application is using a portion of memory at any one time.



extension

The up to three characters which follow the dot (period) after a file name.    The last    three 
characters of a file name, after the period, that denotes what type the file is (i.e. EXE, COM, 
BAT).



FASTHELP

A DOS command that provides summary Help information for MS-DOS commands.



FASTOPEN

A DOS command that decreases the amount of time needed to open frequently used files and 
directories.



FAT

An acronym for File Allocation Table.



fault management

Detects, isolates and corrects network faults.    It is also one of five categories of network 
management defined by the ISO.



fault tolerance

The ability of a system to perform fault management and continue operating in the event of a 
system failure.



fax modem

This is a modem that has the additional capability of interfacing with a standard FAX machine.    
Through the use of special fax software and a fax modem, the computer can send and receive 
FAX transmissions.



FC

A DOS command that compares two files or sets of files, and displays the differences between 
them.



FCBS

This DOS statement specifies the number of file control blocks that DOS can have open at the 
same time.    A file control block is a data structure that stores information about a file.



FDISK

A DOS command which configures a new hard disk for use with DOS.    This program allows you
to establish and change hard disk logical partitions.    Caution: Make a full backup of your 
computer files before using FDISK on an existing hard disk.    Any new partitions created must 
next be formatted before they can be used.



fiber optic cable

Glass or plastic fibers over which modulated light pulses from laser or LED (Light Emitting 
Diode) can transmit data.    It is not subject to interference or electronic eavesdropping.



field

An identifiable area used to contain or enter data.    An example would be an entry field into 
which you can type text.    In a database application, the field information is the information that is
contained in any of the columns (vertical columns) of data.



file

A collection of relevant computer information contained on disk medium.    A collection of related 
data that is stored and retrieved by an assigned name.    A program file can include information 
that starts a program and a data file contains information used by a program during running.



File Allocation Table (FAT)

A table used by DOS to allocate disk space for a file.    It also locates and chains together parts 
of the file that may be scattered on different sectors, so that the file can be used in a random or 
sequential manner.



file attribute

Information about a file that indicates whether the file is read only, system, hidden, or whether it 
has been changed since it was last backed up.



file format

The way information is structured in a file.    Applications always store data files in a particular 
format.    A format readable by one application may not be readable by another application.



file locking

Method of data management which reserves a file for the first user that requests it, thus locking 
out other users.



File Menu

This common main menu choice contains the features of creating a new document, opening an 
existing one, saving changes, printing and exiting the software.    This menu may also contain a 
selection for user preferences or importing or exporting a file in another format.



file name

The name used by a program to identify a file. The string of characters (up to eleven) used to 
denote a file. (LETTER.LET, AR.DBF)    If you are using the file allocation table file system, the 
file name can be up to eight characters and can be followed by a dot (period) and an optional 
three character extension.



file name extension (extension)

The up to three characters which follow the dot (period) after a file name.



file server

A high capacity disk storage device or a computer that stores data centrally for network users 
and manages access to that data.    File servers can be dedicated so that no processes other 
than network management can be executed while the network is available.    File servers can be 
nondedicated so that standard user applications can run while the network is available.



File Transfer Access and Management (FTAM)

An application level protocol governing file access.



File Transfer Protocol (FTP)

A TCP/IP application protocol governing file transfer.



FILES

This statement in CONFIG.SYS sets the number of files that DOS can access at any one time.



Find

This choice in the Edit Menu moves the cursor to the first occurrance of a word or phrase you 
specify.    The "repeat last find" function moves to the next occurrance, etc.    This is usually the 
same as the "search" feature.



FIND

A DOS command that searches for a text string in a file or files.



fixed disk

A rigid disk in a hard disk drive that you cannot remove.    The hard disk can be partitioned into 
storage areas of variable sizes that are sub-divided into directories and subdirectories.    The 
introduction of the fixed disk to the personal computer was an improvement over the previously 
used floppy disks because they could store more information and retrieve it faster.    Also called a
hard disk.



fixed width font

A font in which all characters have uniform widths, such as Courier New.    Also called a 
monospaced font.



flag

A characteristic of a file or directory that enables it to be used in certain ways.    Also called an 
attribute.



flags

These are signals passed between processes.



flexible box

A square box, usually in graphics programs, that changes shape as you move the mouse.    A 
flexible box is used to define an area of a picture you want to change.



flicker

The wavering or unsteady image on some monitors.    A major cause can be a low refresh rate.



floppy disk

A flexible magnetic disk made of plastic and coated with a magnetic material.      The disk can be 
inserted in and removed from a floppy disk drive.    Also called a diskette or removable disk.



flow control

Hardware or software mechanism, such as a buffer, that manages data transmissions when the 
receiving device cannot accept data.    The process used to regulate the rate at which 
information is transferred from one device to another.    Also called handshake.



folder

A container used to organize objects, programs, documents or other folders in OS/2.



font

A particular style, shape, size, slant and weight of typeface defined for an entire character set 
and designated by a family name.



font cartridge

A piece of hardware that is plugged into a printer to supply one or more fonts.    See also 
cartridge font.



font family

A group designation that describes the general look of a font.



font size

The height of a printed character specified in units called points.    A point equals 1/72 of an inch. 
Also known as point size.



footer

Text that appears at the bottom of document pages when they are printed.



FOR

A DOS command that runs a specified command for each file in a set of files.    Ex: "for %%
(variable) in (a set of files) do (a command)"



foreground application

In a multi-tasking environment, this is the program that runs interactively with the user.    The 
application with which you are working.    This is the area of the screen that is occupied by the 
active window.    The foreground application appears in the active window.



format

To prepare a hard disk or diskette to hold information.    Formatting a disk deletes all information 
that was previously on it.



FORMAT

This DOS command formats a disk in the specified drive for use with MS-DOS.    This command 
is used with floppy disks as well as (use caution) hard disks.    It creates a new root directory and
file allocation table for the disk.    Any existing data on the disk will be destroyed.    This program 
magnetically arranges a disk into sectors so that information may be stored to the disk.



forward slash (/)

The forward slash (/) character is used with DOS commands to add switches or options to the 
command to perform additional functions.    For example, the "/s" switch added to the DOS 
BACKUP command means that you want to include all subdirectories.    The forward slash is also
used in some spreadsheet programs to gain access to the main menu of the program.



frame

A collection of bits comprising data and control information formatted for transmission from one 
node to another.    Also called a packet.



front-end

Client application for presenting, entering and updating data.



FTAM

An acronym for File Transfer Access and Management. 



FTP

An acronym for File Transfer Protocol. 



full screen application

A non-Windows or non-OS/2 application that is displayed on the entire screen rather than in a 
window.



function keys

The special keys on a keyboard that are labeled F1 through F12.    Software programs use these
function keys to perform special actions within the program.    The most common function key is 
F1 which usually activates the Help feature of the software.



gateway

A device connecting two or more networks that may use different protocols and media.    
Gateways can connect locally or over wide areas.



GIF

Graphics Interchange Format (.GIF) is a file format established by Compuserve.    It is a 
bitmapped file format, usually 256 color.



gigabyte

A unit of measurement for computer memory equal to 1000 MB (megabytes) or    one billion 
bytes.



glitch

An unwanted and undesirable electrical pulse which causes errors in a program.    This may 
occur because of improper design, power line disturbances or airwave noises.



Go To

This choice in the Edit Menu allows you to move the cursor to the location in the document that 
you specify.    This can be handy to move to a certain page in a document or move to a 
bookmark that you or the program has set.



GOTO

This command directs DOS to a line identified by a label in a batch program.    DOS finds the 
label and processes the next line.



graphics

Any pictorial representation, such as pictures, graphs, bar charts, etc.



GRAPHICS

This DOS command loads a program that can print graphics displayed on the screen.    Use this 
command only if you are using a color or graphics adapter.



graphics card

A printed circuit board that plugs into the motherboard of a computer that sends the signals to a 
monitor for the display.    The display format can be CGA, EGA, VGA, etc.



graphics mode

The mode that enables applications to display images in addition to text.    In contrast to text 
mode.



graphics resolution

The level of quality at which graphics are printed.    The higher the resolution, the better the 
quality of printed graphics but the longer it takes to print.



grayed

A command in a menu or button that is unavailable or disabled.    Usually, it is shown in light grey.
Also called dimmed.



group

A container used to organize objects, programs, documents and accessories within the Program 
Manager in Windows.



group icon

The icon that represents a group in the Program Manager when the group window is minimized.



group window

A window that displays the items in a group.



handshake

The process used to regulate the rate at which information is transferred from one device to 
another.    Also called flow control.



hard copy

Computer output printed on paper.



hard disk

A rigid disk in a hard disk drive that you cannot remove.    The hard disk can be partitioned into 
storage areas of variable sizes that are sub-divided into directories and subdirectories.    The 
introduction of the hard disk to the personal computer was an improvement over the previously 
used floppy disks because they could store more information and retrieve it faster.    Also called a
fixed disk.



hardware

The physical equipment that forms a computer or computer system.



Hayes compatible

A modem that operates the same and uses the same commands as the original Hayes 
Micromodem.    Most communication software requires this type of modem for operation.



HD

An abbreviation for High Density.



header

Text that appears at the top of every page of a document when it is printed.



helical scan

Storage method that increases media capacity by laying data out in diagonal strips.



help

A menu choice or hot key, usually F1, that gives you assistance and information.



HELP

This DOS command provides complete, interactive Help information for MS-DOS commands.    
This command alone will list and briefly describe every command provided with DOS.    If you 
type "HELP [command]" or "[command] /?", DOS will give you help for the command you specify.



help index

A choice in the help menu that presents an alphabetic listing of help topics for the program.



Help Menu

A menu of choices that gives you assistance and information.    This menu usually gives the user 
access to the help system for the software currently being used.    It may also contain a search 
feature to look for a particular topic of interest and/or a tutorial to aid you in using the software.    
This menu also usually contains the ubiquitous "About" box which is a dialog box that gives the 
software name, version number and possibly user or computer system information.



help push button

A push button that, when selected, provides information and assistance.



Hercules Graphics Card (HGC)

This graphics card is compatible with MDA in certain modes, but also capable of displaying 720 x
348 pixels in a 4 bank graphics mode.



hertz (Hz)

A unit of frequency measurement in cycles per second.



heterogeneous networks

Networks composed of hardware and software from multiple vendors usually implementing 
multiple protocols.



hexadecimal

A number system with a base, or radix, of 16.    The symbols used in this system are the decimal 
digits 0 through 9 and six additional digits which are generally represented as A, B, C, D, E and 
F.    Computer programmers use this number system extensively.



HGC

An abbreviation for Hercules Graphics Card.    This is compatible with MDA in certain modes, 
but also capable of displaying 720 x 348 pixels in a 4 bank graphics mode.



Hi-res

Short for High Resolution.    In monitors, this term should be applied to a minimum of 640 x 350 
resolution and above.



hidden attribute

A flag that indicates that a file or directory should not be displayed in the file listing or directory 
tree.



High Density (HD)

Also called high capacity.    Refers to a diskette with higher than standard storage. High density 
diskettes include those capable of storing 1.2 and 1.44 MB of data.    Also refers to the drive 
which uses high density diskettes.



Hz

An abbreviation for hertz.



High Memory Area (HMA)

RAM memory that exists between 1024KB and 1088KB.



high-level language

A computer programming language in which each statement represents several binary code 
instructions.    The statements are familiar and common terms used with computers.



highlighted

Indicates that an object or text is selected and will be affected by your next action. Highlighted 
items appear in reverse video (black background with white letters instead of white background 
with black letters) or in a changed color.



HIMEM.SYS

This command calls the DOS extended memory manager.    It manages the use of extended 
memory on a computer with an 80286 or higher processor and extended memory.



HMA

An acronym for High Memory Area.



HOME key

This key will usually move the cursor to the beginning of the current line of type or the first cell in 
a spreadsheet (usually A1.)    Used in combination with the CTRL or ALT keys, it can move the 
cursor to another location defined by the software.



horizontal scan rate

The frequency in kHz (kilo-Hertz) at which the monitor is scanned in a horizontal direction. EGA 
scans at 21.8 kHz, and the VGA scans at 31.5 kHz.



hot key

A single key stroke or combination of key strokes (sometimes with Shift, Alt or Control) that 
activates a certain menu choice or program function.    When used with a TSR (terminate and 
stay resident) program, the hot key combination activates a program function of the TSR.



How Do I

This choice in the Help Menu gives the user a list of common tasks available in the program and 
explains how to perform those tasks.



hue

The position of a color along the color spectrum.



I/O

An acronym for input and/or output.



I/O address

An acronym for Input/Output address.



IC

An acronym for integrated circuit.



icon

A graphical representation of an object consisting of an image, image background and a label.



IF

This command performs conditional processing in batch programs.    For example:  IF [condition] 
GOTO label.    If the condition is true, the command "goto label" is executed.



image

A still picture or one video frame.



impedance

Measurement of resistance to current that a transmission medium offers.    It is measured in 
ohms.



import

To bring a document or object created by another program into the current application and 
convert its format to the format of the current application.



inactive window

A window in which you are not currently working.    This window cannot receive input from the 
user.



Industry Standard Architecture (ISA)

IBM PC and compatible bus architecture with a 16 bit data path.    The popular architecture for 
personal computer buses, such as the IBM PC, XT and AT.



INI

Files with the extension .INI that contain information that defines your Windows environment.    
Windows and applications use the information stored in these files.



initialization files

Files with the extension .INI that contain information that defines your Windows environment.    
Windows and applications use the information stored in these files.



initialize

To establish the initial default status of a device.



ink-jet printer

A printer that forms characters by squirting a tiny jet of ink onto the paper.    The jet is directed by 
a magnetic field controlled by electronic circuits in the printer.



input

Information that needs to be entered into a computer.    The most common forms of input to a 
computer are the typing you do on the keyboard and the movement of the mouse and/or clicking 
the mouse buttons.



input peripheral

Any device that transfers information into a computer.    A keyboard and mouse are common 
examples.



Input/Output address (I/O address)

Starting address for data input and output.    The location within the input/output address space 
of your computer used by a device.    The address is used for communication between software 
and a device.



input/output device

Computer equipment used to load information into the computer and to read information from the
computer.



INSERT key

This key is usually used in word processing programs to toggle between the insert and the 
typeover modes of operation.    In the insert mode, letters typed on the keyboard are added to 
the document at the cursor insertion point.    In the typeover mode, letters typed on the keyboard 
replace letters that exist in the document at the cursor insertion point.



insertion point

The place where text will be inserted when you type.    The insertion point usually appears as a 
flashing bar (cursor) or box in an application's window or in a dialog box.



install

To physically copy, expand and configure the files of a software program from diskettes to 
specified areas (directories) of the hard drive.



INSTALL

A DOS command used in CONFIG.SYS.    This command loads a memory resident program into 
memory.



instruction set

A collection of instructions that a computer can understand.



Integrated Circuit (IC)

A miniature electronic circuit that is imprinted on the surface of a silicon chip.



Integrated Services Digital Network (ISDN)

Protocols proposed for carrying voice, data, facsimile and video signals across a network.



interface

The linkage between two parts of a computer or between a computer and an accessory.    The 
connection between the computer and another device.    The area of connection through which 
information can be exchanged.



INTERLNK

This DOS command starts the Interlnk program which connects two computers via parallel or 
serial ports and enables the computers to share disks and printer ports.



International Standards Organization (ISO)

An international organization that creates networking standards, including the OSI (Open 
Systems Interconnections) model.



Internet

A system of connected networks including those of the National Science Foundation and the 
Advanced Projects Research Agency.



internetwork

A collection of two or more connected networks that may be dissimilar.



interoperability

The ability to operate and exchange information in a heterogeneous network.



interrupt

A signal that a device sends to the computer when the device is ready to accept or send 
information.    A temporary and usually brief halt in the execution of a program so that a computer
can perform some other function.    As soon as the function is performed, control is returned to 
the program.    Also, a procedure whereby applications can access information from DOS.



interrupt request

The method by which hardware devices request processor attention within a computer.



Interrupt Request Lines (IRQ)

Hardware lines over which devices can send interrupts (signals indicating that the device is 
ready to accept or send information).    Typically, each device connected to a computer uses a 
separate IRQ.



INTERSVR

This DOS command starts the Interlnk server.



IRQ

An acronym for Interrupt Request Lines.



ISA

An acronym for Industry Standard Architecture.



ISDN

An acronym for Integrated Services Digital Network.



ISO

An acronym for International Standards Organization. 



italics

A typestyle in which the characters slant.



jabber

Network error caused by an interface card continually sending corrupted data onto the network.



job

A data file sent to a printer to be printed.



joystick

An input device that enters positional information into a computer.    This device usually contains 
control buttons and a movable shaft that permits positional information to be transferred into a 
computer.    This type of control is commonly used with games.



JPEG

Joint Photographic Experts Group format is a specially compressed graphics file in bitmapped 
format.    The file size is much smaller than a similar graphic picture in other formats.



jumper

A small, rectangular, plastic covered metal clip that fits over two metal pins on a circuit board.    
This is used for selecting different configurations for the circuit board.    A jumper is SET or ON 
when it connects the two pins and OFF when it is removed.



K

An acronym for 1,000 in common usage or kilobyte in reference to computer memory.



KB

An abbreviation for kilobyte.



kernel

The part of an operating system that performs basic functions, such as allocating hardware 
resources, OR a part of a program that must be in main storage in order to load other parts of 
the program.



KEYB

This DOS command configures a keyboard for a specific language.



keyboard

An array of keys or buttons that permit instructions and numerical information to be entered into 
a computer by the user.



keyboard buffer

A temporary storage area in memory that keeps track of keys that you typed, even if the 
computer or monitor did not immediately respond to the keys when you typed them.



keys help

A help menu choice that gives a listing of all the hot key assignments for a program.



kilobyte (KB)

A common way of describing the memory capability of a computer in approximately 1,000 units.   
One kilobyte of computer memory is exactly 1024 bytes.



label

A line in a batch file used as a marker for the GOTO statement.    The label is a name preceded 
by a colon (Ex. :end).



LABEL

This DOS command creates, changes, or deletes the volume label (name) of a disk.



LAN

An acronym for Local Area Network. 



LAN Manager

Microsoft's network operating system based on OS/2.



LAN Server

IBM's implementation of a network operating system based on OS/2.



LAN-aware

Applications that have file and record locking for use on a network.



LAN-ignorant

Applications written for single users only.    These are not recommended for use on LANs.



LAN-intrinsic

Applications written for client-server networks.



language

An organized system of words, phrases and symbols that permit a computer programmer to 
communicate with a computer.



laptop computer

This portable, battery powered, type of computer resembles a notebook computer but weighs 
slightly more.    A typical laptop weighs about 14 pounds.



Large Scale Integration (LSI)

A technology of chip manufacturing for CPU's and other large microprocessors.



laser printer

This type of printer shoots laser beams at an internal photocopying machine that copies the 
pattern of light onto paper.    A laser printer prints a character by printing a pattern of dots.    The 
character appearance is better quality because the laser printer's dots are very tiny and shapes 
are more clearly defined (300 to 600 dots per inch).    Some printers can also vary the size and 
position of the dots.    These printers are typically the most expensive to purchase and operate.



LASTDRIVE

This DOS command specifies the maximum number of drives you can access.    The value 
entered represents the last valid drive that DOS is to recognize.



LAT

An acronym for Local Area Transport. 



LCD

An acronym for Liquid Crystal Display.    A display screen with black characters on a white 
background.    This display type is used on battery powered models like notebook and laptop 
computers.



leased line

A private telephone line reserved for the leasing customer's use.



LED

An acronym for Light Emitting Diode.



left click

To press and release the left mouse button while pointing at an object.



letter quality

The capability of a printer to produce letters that closely resemble the appearance of a typed 
letter.    A print quality which produces better readability and appearance at a reduced print 
speed.



LH

This DOS command loads a program into the upper memory area.    Same as loadhigh.



light pen

A probe containing a light sensitive cell which, when pointed at the monitor screen, can make 
selections or input instructions to the computer.



line feed

A control code and panel button on a printer that advances the paper one line space.



line

A horizontal collection of words or instructions in a computer file terminated by a carriage return.  
This term is commonly used in connection with writing batch files.



link

To create a reference in a destination document to an object in a source document.    When you 
link an object, you are inserting a visual presentation of the object into the destination document. 
When the object changes in the source document, the changes appear in the destination 
document.



linked object

A visual presentation of an object in a destination document.



Liquid Crystal Display (LCD)

A display screen with black characters on a white background. This display type is used on 
battery powered models like notebook and laptop computers.



list box

A vertical, scrollable list of choices from which you can select.



load

To copy information, or a program, from a computer file on disk into RAM memory so it can be 
used, or so you can work with it.    You load a program to be used and/or load a document into a 
program so you can work on it.    Opposite is save which copies the current document onto disk 
for storage.



LOADFIX

This DOS command loads a program above the first 64K of memory, and runs the program.



LOADHIGH

This DOS command loads a program into the upper memory area.



loading position

The position to which the paper in a printer is automatically loaded.



Local Area Network (LAN)

A system of software and hardware (computers, printers, etc.) connected by a common data 
transmission medium (cable) and limited to a geographical area less than about 10 kilometers.    
Two or more computers connected for local resource sharing.



Local Area Transport (LAT)

DECnet protocol governing communication between terminals and hosts.



local printer

A printer that is directly connected to one of the ports on your computer.



LocalTalk

A 230 kilobits per second baseband network using the CSMA/CA access method.



log in

To begin a session with a remote resource.    The act of identifying yourself as authorized to use 
a remote resource.



log out

To end a session with a remote resource.    The act of removing access to a remote resource 
from a workstation.



logical drive letter

 A logical drive letter is the letter designation used by the operating system to identify a memory 
location on a drive.



LOGO

This is a computer language used in elementary schools.



loop

A sequence of one or more instructions in a computer program that are executed repeatedly until
certain conditions have been met.



loopback

A diagnostic test in which a signal is transmitted across a medium while the sending device waits
for its return.



loosely coupled

A multiprocessor computer in which the CPUs (Central Processing Units) have separate memory
and system buses.



low DOS memory

Another term for conventional memory.    This is Random Access Memory (RAM) that begins with
address zero and extends to the lowest address in the video display region (640K). This is the 
first 640KB of RAM memory in your computer.    The operating system uses this memory to run 
applications.    Conventional memory is available on all PC's.    Also called DOS memory or 
conventional memory.



low-level language

A computer programming language in which the programmer can access memory address 
locations in the computer.    This type of language is more versatile but usually requires more 
code to perform a function and it is more difficult to learn.



LPT port

A 25 hole I/O port on the back of the computer used for processing and transmitting data (usually
LPT1 to LPT3).    It connects to a cable with a 25 pin connector.    This is a parallel port.



LSI

An acronym for Large Scale Integration. 



luminosity

The relative brightness of a color on a scale from black to white.



M

An abbreviation for megabyte.    In common usage, this is another abbreviation for 1,000.    



machine

A computer.    Yes, it is only a machine!



machine language

A computer's native language of binary code using 0's and 1's.    All executable programs are 
converted into the binary code of machine language so the computer can process the 
information.



macro

A series of instructions requiring multiple keystrokes or menu choices that are recorded and 
saved and can be played back at anytime with a single keystroke or action.    A macro in a 
software application is similar to a batch file in DOS.



magnetic disk memory

A computer memory that stores binary information on disks of various sizes which are coated 
with a magnetic substance.



main menu

The primary menu which governs the overall functions of a software program.



MAN

An acronym for Metropolitan Area Network. 



Manchester encoding

A digital encoding method that describes a bit value by the transition between two signals, and is
self-clocking.



Manufacturing Automation Protocol (MAP)

A version of the OSI (Open Systems Interconnection) model for manufacturing environments 
developed by General Motors.



MAP

An acronym for Manufacturing Automation Protocol.



mapping

Redirecting local resources to network resources.



mark

A menu choice or mouse action of click, or click and drag, to highlight text or graphics where you
want to perform specific operations, like cut, copy, delete, etc.



math coprocessor

This is special circuitry that works with the computer's CPU (microprocessor) to carry out 
complex arithmetic functions.    The math coprocessor can perform the complex arithmetic faster 
than the microprocessor can alone.    On computers with a 80386 or earlier CPU, this function is 
contained in a separate chip that is installed on the motherboard.    The 80486 and later 
microprocessors have the math coprocessor built into the microprocessor chip itself.



maximize

A menu choice or button which will enlarge a window to its largest possible size.



maximize button

A push button in the rightmost corner of the title bar of a window that enlarges the window to its 
largest possible size.



MB

An abbreviation for megabyte.



MCA

An acronym for Micro Channel Architecture.



MCI

An acronym for Media Control Interface.



MD

This DOS command, "Make Directory," creates a directory underneath the current directory or 
subdirectory on your disk.    See also MKDIR.



MDA

An abbreviation for Monochrome Display Adapter.    This is an early IBM Video display 
designed for use with IBM monochrome text standard.



Media Control Interface (MCI)

A standard control interface for multimedia devices and files.



media file

A file containing multimedia data.



megabyte (MB)

A unit of measurement for computer memory equal to 1024 KB or 1,048,576 bytes.



megahertz (Mhz)

A unit of speed measurement in millions of cycles per second.



MEM

This DOS command displays the amount of used and free memory in your system.    This is most
useful for checking the amount of free conventional memory on your system.



MEMMAKER

This DOS command starts the Memmaker program, which optimizes your computer's memory 
by configuring device drivers and memory resident programs to run in the upper memory area.



memory

The circuits, components or mechanical parts of a computer that store information.    Types of 
memory used in a computer are Random Access Memory (RAM), Read Only Memory (ROM) 
and disk storage memory.



memory resident program

Any program that remains active in memory when other programs are running.    It is not visible 
until you press a certain key combination or until a certain event occurs.    A typical example is a 
screen saver program that will activate after a certain time period, or if the user presses a certain
key combination.    Also called terminate and stay resident or pop up program.



menu

A list of choices displayed by a computer program from which the user may select an option for 
execution.    A list of program options, displayed on a monitor, for operator selection.    A menu is 
used so that the computer user does not need to remember any commands in order to use the 
software program.



menu bar

The area near the top of a window, below the title bar that contains choices that provide access 
to other menus.



message box

A dialog box that gives you information.    This dialog box may be initiated by the application or 
the operating system itself.    Its purpose is to convey information only and usually contains an 
"OK" button.    Select the button to close the dialog box and continue with your work.    The About 
Box is a typical example of a message box.



Metropolitan Area Network (MAN)

A network capable of high speed data communication over distances up to about 80 kilometers.



MHz

An abbreviation for megahertz.



micro feed

A feature on some printers used to feed paper either forward or backward in very small 
increments.



micro adjustment

A feature on some printers that adjusts the paper loading and tear-off positions.



Micro Channel Architecture (MCA)

IBM's proprietary bus architecture that offers improved performance over ISA (Industry Standard 
Architecture) and is used primarily in PS/2 and compatible computer systems.    These can be 
driven by multiple independent bus master processors.



microcomputer

A computer that uses a microprocessor for a central processing unit. Nearly all personal 
computers are microcomputers.



microprocessor

An integrated circuit that contains the complete central processing unit for a personal computer.



MIDI file

A file used for audio sounds on a sequencer device.



MIDI

An acronym for Musical Instrument Digital Interface.



migrate

To move to a changed operating environment.    Usually used in connection with Windows or 
OS/2 to bring applications into their environment so the application can be run from this 
operating platform.



minimize

To remove a window and display it as an icon at the bottom of the main window in Windows or 
place the icon in the minimized window viewer of OS/2.



minimize button

A push button located next to the rightmost button in a title bar that removes the window and 
displays it as an icon.



minimized window viewer

A folder in OS/2 that contains icons of minimized windows.



mirroring

A fault tolerance method in which a backup data storage device maintains data identical to that 
on the primary device, and can replace the primary if it fails.



mixer

A device or program used to simultaneously combine and blend inputs from several sources into 
one or two output destinations.



MKDIR

This DOS command, "Make Directory," creates a directory underneath the current directory or 
subdirectory on your disk.    See also MD.



modal dialog box

A dialog box that halts all other operations until the dialog box is completed and closed.



MODE

Configures system devices such as printers, ports or display modes.



modem

An acronym for modulator-demodulator.    A device that converts digital and analog signals.    
This is a device that permits computers to communicate with one another over telephone lines.



modulation

The alteration of a signal's frequency, phase or amplitude.



monitor

The television-like device on which computer information is displayed on a screen.    Also called 
a video monitor.



monochrome monitor

A TTL monitor which can display only two colors (generally black/white or green/black).



monospaced font

A font in which all characters have uniform widths, such as Courier New.    Also called a fixed 
width font.



MORE

A DOS command that displays output one screen at a time.    This command is commonly used 
to view long files (TYPE command) or long screen displays (DIR command).    It is added to 
another command with the (pipe) vertical lines (Ex: DIR |MORE).



morphing

This is the process used by a computer to change one graphical image into another.    For 
example, the picture of a young boy can be slowly changed into a picture of a lion.



motherboard

This is the main circuit board inside a computer that contains most of the components necessary
to the proper operation of the computer including the CPU, clock, RAM memory, and others.    
Most of the peripheral devices are plugged into, or in some way connected to, the motherboard.



mount

The method in NFS and other networks by which nodes access network resources.



mouse

A palm sized pointing device that you move on a flat surface which creates a corresponding 
movement of an arrow or pointer on the screen.    It has buttons that allow you to select a choice 
or function to be performed or to perform operations on the screen.



mouse button

A mechanism on a mouse that you press to select choices or initiate actions.



move

To change the location of an object.



MOVE

This DOS command moves one or more files to another directory.    This command can also 
rename files and directories.



MSAV

This command starts the DOS anti-virus program which scans your computer for known viruses.



MSD

This DOS command starts the Microsoft diagnostics program which provides detailed technical 
information about your computer.



MS-DOS

An acronym for the Microsoft Disk Operating System, commonly called DOS.



MSBACKUP

This DOS command backs up or restores one or more files from one disk to another.    This utility
is available with DOS version 6.0.    It has a menu based user interface and can operate faster 
than the former BACKUP command because it can use file compression.



multi-user software

An application designed for simultaneous access by two or more network nodes.    It typically 
employs file and/or record locking.



multicast

An address for a selection of nodes in a network or the message sent to a selection of nodes.



multimedia

The combining of different elements of media (text, graphics, sound, video) for display and 
control from a personal computer.



multimedia system

A system capable of presenting multiple types and formats of material (text, graphics, sound, 
video) in their entirety.



multiple document interface (MDI)

An application program that can have more than one document or item open at a time.    Only 
one of the documents may be active at a time, but the user may switch between open 
documents easily.    For example, the Windows program SYSEDIT opens all four of the startup 
files for the computer system at the same time and the user can look at and edit any one at will.



multiprocessor

A computer with more than one Central Processing Unit (CPU) that can be accessed 
simultaneously by an operating system adapted to this architecture.



multitasking

A mode of operating that provides for concurrent performance or interleaved execution of two or 
more tasks.    The process of switching from one task to another without losing track of either.    
Usually accomplished by time slicing any shared resources.



Musical Instrument Digital Interface (MIDI)

A protocol that allows a synthesizer to send signals to a computer or a computer to a musical 
instrument.



NetBIOS

An acronym for Network Basic Input/Output System.



NetWare

Novell's network operating system using IPX (Internetwork Packet Exchange) and SPX 
(Sequential Packet Exchange) protocols.



network

A group of computers connected by cables or other means and using software that enables them
to share equipment and exchange information.    A system of software and hardware connected 
in a manner to support data transmission.    An arrangement for interconnecting a number of 
computers and allowing them to share information and peripheral devices.



network administrator

The person responsible for the installation, management and control of a network.



network architecture

A description of data formats and procedures used for communication between nodes.



Network Basic Input/Output System (NetBIOS)

A widely used protocol governing data exchange and network access.



network drive

A disk drive that is available to multiple users and computers on a network.    Network drives 
often store data files for many people in a work group.



Network Interface Card

Adapter board that provides the physical connection between a computer and the network 
medium.    Also called Network Interface Controller.



Network Interface Controller (NIC)

Adapter board that provides the physical connection between a computer and the network 
medium.    Also called Network Interface Card.



Network Loadable Module (NLM)

An application or driver that resides on a NetWare server to provide additional resource 
management capabilities.



Network Operating System (NOS)

Controlling software for a network, which may run on top of DOS, that oversees resource sharing
and often provides security and administrative tools.



network printer

A printer shared by multiple computers over a network.



network topology

The arrangement of nodes usually forming a star, ring, tree or bus pattern.



New

This choice in the File Menu allows the user to create a new document and specify the beginning
parameters for that document.    Note, the document is not saved to disk until you specifically 
save it with a new name with the "Save As" feature.



NIC

An acronym for Network Interface Controller.



NLM

An acronym for Network Loadable Module.



NLSFUNC

A DOS command that loads country-specific information for national language support.



node

Any device, including servers and workstations, connected to a network.    Also, the point where 
devices are connected.



nondedicated server

A node on which user applications are available while network resource maintenance 
applications execute in the background.



nonsolid color

A color produced by a pattern of differently colored dots that simulate the desired color.    Also 
known as dithered color.



nonvolatile

A term used in reference to a computer memory that stores information with or without electrical 
power.    The information is not lost when electrical power is turned off.



NOS

An acronym for Network Operating System.



notebook

A graphical representation that resembles a bound notebook that contains pages separated into 
sections by tabbed dividers.    It also contains a mechanism that you can use to turn the pages.



notebook computer

This is a complete portable, battery powered, computer system that is about the size of a three 
ring binder.    It typically measures about one foot square by about 2" thick and weighs about 7 
pounds.    The notebook unfolds to expose the monitor screen and keyboard underneath.



NUM LOCK key

This number lock key is used to toggle the function of the number pad on the right side of the 
keyboard.    With the number lock on, NUM LOCK light lit, the keys produce the numbers 
indicated.    With the number lock off, the same keys perform the cursor movement functions 
indicated.    The computer's CMOS usually has a setting for the state of the number lock and it is 
usually set to be on.    The DOS operating system usually leaves the number lock on, whereas 
the OS/2 operating system usually turns it off.



O/S

An abbreviation for operating system.



object

Something with which you work to perform a task.    Text, graphics, files and devices are 
examples of objects.



Object Linking and Embedding (OLE)

(pronounced O'Lay) A way to transfer and share information between applications.    OLE links 
are similar to DDE links, except you can start the source (server) application from within the 
current (client or receiving) application to edit the linked object.    An OLE object can be linked or 
embedded.    A linked OLE object leaves the data stored in the source (server) application file.    
In an embedded OLE object, the data for the object is stored in the current (client or receiving) 
application file.



OCR

An acronym for optical character recognition.



off-line

The status of being disconnected from the referenced device or service.    A user is considered to
be off-line if he is not connected to a BBS.    A printer is considered to be off-line if it is not ready 
to print for some reason.    Opposite is on-line.



OLE

An acronym for Object Linking and Embedding (pronounced O'Lay.)



on-line

The status of being connected and ready to do something.    This term is often used in 
connection with a BBS (bulletin board system) whereby the user is connected to the BBS and is 
able to do something like chat with other users, download files, etc.    In the case of a printer, the 
printer is said to be on-line if it is connected to the computer, turned on, loaded with paper and 
ready to print.    Opposite is off-line.



open

To create an object or make an existing file available for processing or use.    To display the 
contents of a file in a window or to enlarge an icon to a window.



Open

This choice in the File Menu allows the user to call up an existing document on disk and view or 
work on it in a new document window.    Any changes made to the document should be saved to 
disk using the "Save" feature.



operating system (O/S)

The software required to manage the hardware and logical resources of the system, including 
device handling, process scheduling and file management.    MS-DOS by Microsoft, PC-DOS by 
IBM and OS/2 by IBM are operating systems.



optical character recognition (OCR)

This is a type of software that is used to convert text in a graphical image into a word processor 
format that can be used by a computer.



option

A choice in a dialog box or menu.    An additional parameter added to a command line to control 
how a command is carried out.    Optional parameters (also called switches) usually follow a 
space and a forward slash (/).



Options Menu

This menu contains program options that are available to the user.    Selections may include the 
display colors available to the user as well as other specific program options.    This feature is 
sometimes part of the Preferences selection sometimes contained in the File menu.



OS/2

IBM's multi-threaded, multitasking, single user operating system.



output

Information that comes from a computer and is sent to some device to be operated upon (like a 
printer or modem) or displayed to the user (like on a monitor.)



output peripheral

Any device designed to receive information or signals from a computer. Monitors and printers are
common examples.



package

A small drawing (or icon) that represents an embedded or linked object.



packet

A collection of bits comprising data and control information formatted for transmission from one 
node to another.    Also called a frame.



packet filter

The ability to search a packet to determine its destination and then to route it accordingly.    This 
ability helps to control network traffic.



packet forwarding

Copying the packet to another node without looking at the destination address.



packet switching

A data transmission method that routes packets along the most efficient path and allows a 
communication channel to be shared by multiple connections.



PAGE DOWN key

This key will usually move the cursor to the beginning of the next page of a document.    Used in 
combination with the CTRL or ALT keys, it can move the cursor to another location defined by 
the software.



page frame

A 64KB block of memory in the upper memory area.    Available expanded memory is mapped 
into addresses in the page frame so it can be accessed and used by the operating system.



PAGE UP key

This key will usually move the cursor to the beginning of the previous page of a document.    
Used in combination with the CTRL or ALT keys, it can move the cursor to another location 
defined by the software.



paragraph

A 16 byte unit of measurement for computer memory.



parallel port

A 25 hole I/O port on the back of the computer used for processing and transmitting data (usually
LPT1 to LPT3).    It connects to a cable with a 25 pin connector.    This type of port is usually used
to connect a printer to a computer.



parallel data transmission

Two or more bits of a group are transmitted in parallel when they are all transmitted at the same 
time.



parallel interface

An interface between a computer and another device, such as a printer, in which the computer 
sends multiple bits of information to the device (printer) simultaneously.



parameter

A variable used in conjunction with a command to affect its result.



parity

A form of single bit error detection.



parity check

A mathematical operation on the numerical representation of the information communicated 
between two devices or telecommunicated by a modem.



partition

A fixed sized division of storage on a hard disk.



PASCAL

A structured high-level programming language which is taught in college.



passive device

A device that does not supply current for the loop in a network.



password

A string of characters that you or a program must specify to meet security requirements before 
gaining access to a system and to the information stored in it.



paste

This menu or button choice copies the contents of the clipboard into a preselected location.



Paste

This choice in the Edit Menu copies the contents of the clipboard into a preselected location in 
the current document.



Paste Format

This choice in the Edit Menu, if available, will establish an OLE link with the information 
contained on the clipboard that has originated from another application.    OLE links are similar to
DDE links, except you can start the source (server) application from within the current (client or 
receiving) application to edit the linked object.    An OLE object can be linked or embedded.    A 
linked OLE object leaves the data stored in the source (server) application file.    In an embedded
OLE object, the data for the object is stored in the current (client or receiving) application file.



Paste Link

This choice in the Edit Menu, if available, will establish a DDE link with the information contained
on the clipboard that has originated from another application or another place in the same 
application.    Any changes made to the data in the source (server) application will automatically 
and dynamically be also changed in the current (client or receiving) application.



Paste Special

This choice in the Edit Menu, if available, is used to paste information from the clipboard with or 
without the formatting that goes with the information.    For example, you can paste a block of 
text without the font, alignment, etc. properties that it had in its original place.



path

A statement that indicates where a file is stored on a particular drive and directory.



PATH

A DOS command which displays or sets a search path for executable files.    DOS uses the 
PATH statement to find files you want to execute if the file is not in the current directory.    The 
directories are searched in the order that they appear in the PATH statement.



path name

The complete name and location of a file or directory located in a computer system.    The path 
name includes the drive letter followed by a colon (:) and a backslash (\), the directory name or 
names, each separated by a backslash (\), and finally a file name also separated from the 
directory name with a backslash (\).    This is a very exact way of locating something or telling the
computer where you want to be or what you want done.    An example of a path name is the 
command "c:\windows\win" which is the command that normally starts the Windows operating 
system.



PAUSE

A DOS command which suspends processing of a batch file and displays a message prompting 
the user to press any key to continue.    This command is typically used to stop batch file 
processing while the user prepares some hardware device, such as insert a disk into drive A, or 
turn on the modem, etc.



PAUSE key

This key is used to temporarily halt the execution of a batch file so the user can view the output 
on the monitor screen.    The monitor screen display can be read or, using the "Print Screen" 
function, it can be printed.    The ESC key is typically used to continue execution of the batch file.



PC

An acronym for personal computer.



PC/AT

An acronym for a personal computer based on the 80286 microprocessor.



PCD

This is a Kodak Photo CD file in bitmapped format.    The file actually contains five different 
resolutions of a slide or film negative.



PC-DOS

An acronym for Personal Computer - Disk Operating System.    This is the proper name for the 
IBM version of the DOS operating system. 



PCMCIA (Personal Computer Memory Card International Association)

A standard developed by an association for credit card sized memory and I/O cards for portable 
computers.    Examples are Fax/Modem, LAN adapters, SCSI host adapters and audio cards.



PCX

This is a bitmapped graphic file format, with extension .PCX, created by paint programs like PC 
Paintbrush or some screen capture programs.    This is one of the oldest and most common 
bitmap formats available.



PC/XT

An acronym for a personal computer based on the 8088 microprocessor.



peer to peer

A system in which two or more nodes or processes can initiate communication with each other.    
Usually describes a network in which all nodes have the ability to share resources with other 
nodes so that a dedicated server can be implemented but is not required.



pel

An acronym for picture element.    The smallest graphic unit that can be displayed on the screen, 
usually a single colored dot.    Also known as pixel.



Pentium

The name used by Intel for the next generation of CPU (central processing unit) chips after the 
80486 CPU.    This CPU, introduced in 1993 has a 64 bit internal bus and it typically runs at 66 to
99MHz clock speed.



percent

The percent symbol is used to call a command line parameter (%0 to %9) or an environment 
variable (%variable%) in a batch file.    (See replaceable parameters and the SET command.)



performance management

Measures and records resource utilization.    It is one of the categories of network management 
defined by the ISO.



peripheral

Any input or output circuit or device designed to be connected to a computer.



personal computer (PC)

A microcomputer equipped with input devices like a keyboard and output devices like a monitor 
and printer.



phase modulation

Altering a characteristic of a sine wave, specifically its phase.



physical drive letter

A physical drive letter is the letter used in the CMOS to identify a physical drive device (a piece 
of hardware).



PIF

An acronym for program information file.



pin printer

A printer that forms characters from patterns of closely spaced dots.    A high-speed printing 
device which forms letters and numbers by dots.    The number of pins on the print head 
determine how many dots it takes to form each character.    Also called a dot matrix printer.



pinouts

Pin configurations for cables used to connect devices to computers.



pipe

A device that acts as an interface or buffer between applications and devices.



pixel

A single dot on the CRT display.    This word is derived from the words "picture" and "element."    
The smallest graphic unit that can be displayed on the screen, usually a single colored dot.    The
more dots on the screen yield a finer resolution.    Also known as pel.



platen

The black roller on dot matrix printers (and a typewriter) that provides a backing for the paper 
during printing.



plotter

An output device that uses multiple pens to draw on paper.    Usually used with computer aided 
design (CAD) software.



plotter font

A font created by a series of dots connected by lines that can be scaled to different sizes (used 
by plotters).    Also known as vector font.



point

To move the pointer on the screen until it rests on the item you want to select.



point size

The height of a printed character specified in units called points.    A point equals 1/72 of an inch. 
Also known as font size.



point to point link

A direct connection between only two nodes.



pointer

The arrow, crosshair, pencil or other shape that appears on your screen and follows the 
movement of the mouse.    (Equivalent to the cursor when using the keyboard)



pointing device

An input device (mouse) used to move the pointer on the screen.



polling

A network access method with which a hub asks each node in turn if it has data to transmit.



pop up menu

A menu that is displayed next to the object with which it is associated.



pop up program

Any program that remains active in memory when other programs are running.      It is not visible 
until you press a certain key combination or until a certain event occurs.    A typical example is a 
screen saver program that will activate after a certain time period, or if the user presses a certain
key combination.    Also called memory resident or terminate and stay resident program.



pop up window

A movable window, fixed in size, in which you provide information required by an application so 
that the application can continue to process your request.



port

A connector on a computer to which cables for devices or communication lines are attached.    
Ports can be parallel or serial.



port designation

A 4-character identifier (COM1, COM2, LPT1, etc.) assigned to a port so that the system has a 
unique way to refer to the resource.



POWER

A DOS command that turns power management on and off.



power supply

The electrical circuits that convert power from an electrical outlet in a house into a form suitable 
for use by a computer.    The computer's power supply is normally included with the computer 
case.



Preferences

This choice in the File Menu allows the user to select his desires for the operation of the 
program.    The choices may include display colors, function key features, tool bar use, etc.



preselected choice

A choice highlighted and selected by the program when a choice field first appears.



Print

This choice in the File Menu will start the printing process.    Usually, another dialog box is 
displayed giving choices of number of copies to print, what pages to print, etc.    There is usually 
a button available to allow the user to go to the "print set-up" function if desired.



PRINT

A DOS command that prints a text file while you are using other DOS commands.    This 
command creates a memory resident program that can print in the background.    The first time 
you use the command, the computer will ask you "Name of list device [PRN]:".    Simply press 
ENTER or type "PRN" or "LPT1" and ENTER to instruct DOS to which port you are sending the 
printing information.



print queue

A list of files that have been sent to a printer.    The list indicates the file currently printing and 
those waiting to be printed.



PRINT SCREEN

A key on an enhanced keyboard which, when pressed, will send the monitor display information 
to the printer to be printed.    This key will function as soon as the BIOS is active and even before
the operating system is loaded.    The use of this key (or SHIFT+PRINT SCREEN on some 
computers) is handy for printing your BIOS set up information and information that is presented 
on your screen during the boot up sequence.    The printed information is very basic (it does not 
include special characters) but it is readable.



print server

A computer that manages printers and print requests from other nodes.



Print Set-up

This choice in the File Menu allows the user to select the printer driver to be used, paper 
orientation, etc.



print spooler

An application that manages print requests or jobs so that one job can be processed while other 
jobs are placed in a queue (An ordered list of items waiting to be processed.) until the printer has
finished with preceding jobs.    Also called Simultaneous Peripheral Operation On-line (SPOOL).



printable area

The area of a page on which the printer can print.    This is smaller than the physical size of the 
page due to margins required by the printer.



printer

A mechanical device that prints information on single or continuous sheets of paper.



printer driver

A program that controls how your computer and printer interact.    A printer driver file supplies 
such information as the printing interface, description of fonts and features of the installed 
printer.



printer fonts

Fonts that are stored in your printer's memory, or soft fonts that are sent to your printer before a 
document is printed.



printer port

A 25 hole I/O port on the back of the computer used for processing and transmitting data (usually
LPT1 to LPT3).    It connects to a cable with a 25 pin connector.    This type of port is usually used
to connect a printer to a computer.



PRINTER.SYS

A DOS file that supports code-page switching for printers.



program

A sequence of instructions that a computer can interpret and process.    Also called software.



program file

An executable file that starts an application or program.    A program file has a file name 
extension of .EXE, .PIF, .COM or .BAT.



program information file (PIF)

A file that provides information about how Windows should run a non-Windows application.



program item icon

The icon that represents an application or document in the Program Manager.



program items

The applications and documents that make up a group in the Program Manager.    Program items
are represented as icons in a group window.



Program Manager

The main application in the Windows environment that normally runs when you start Windows.    
The Program Manager window sits on the Windows desktop and contains all the groups and 
applications for the user.    The Program Manager contains the commands to close or exit 
Windows.



Programmed Input/Output (PIO)

A method of data transfer in which the host microprocessor transfers data to and from memory 
via the computer's I/O ports.    PIO enables very fast data transfer rates, especially in single-
tasking operating systems like DOS.



prompt

A message from a computer advising the user that the computer is waiting for some kind of 
action.



PROMPT

This DOS command changes the MS-DOS command prompt display.    You can have it display 
the current path, time or date as well as the DOS version, greater than, less than, dollar sign, 
equal sign, etc.    The most common configuration is ($P$G) which displays the current drive and
path and the greater than sign.



propagation delay

The time required for data to travel from transmission point to destination.



proportional font

A font in which different characters have varying widths, such as Times Roman.



proportional printing

Printing in which the width of the character varies from character to character depending on the 
particular character printed.    The result looks more like a typeset book than a typewritten draft.   
For example, a "W" receives much more space than an "i".



protected mode

CPU (Central Processing Unit) mode in which applications must request memory allocations 
from the operating system and these allocations are then protected from other applications' 
requests.      A mode of operation covered by the DPMI specification whereby DOS programs can
access more than 1 megabyte of memory.



protocol

A standardized set of rules that specify the format, timing, sequencing and/or error checking for 
data transmissions.    A set of rules that define how computers communicate with each other.



protocol stack

A representation of the hierarchical nature of a protocol suite.



protocol suite

A hierarchical set of related protocols.



publishing

Making resources available to network users.



QBASIC

This command starts the MS-DOS QBASIC programming environment.    The QBASIC program 
provides a complete environment for programming in the BASIC language.    This program reads
instructions in BASIC and interprets them into executable computer code.



QBE

An acronym for Query By Example.



Query By Example (QBE)

A database front end that requests the user to supply an example of the type of data to be 
retrieved.



query language

A programming language that permits users to retrieve information from a database.



question mark (?)

A wildcard that represents a single character.



queue

An ordered list of items waiting to be processed.    A list of files that have been sent to a printer.    
The list indicates the file currently printing and those waiting to be printed.    Also called print 
queue.



quick format

Deletes the file allocation table and root directory of a disk, making it appear empty.    It does not 
delete the file information on the disk or scan the disk for bad areas.



radix

A number that is arbitrarily made the fundamental number of a system of numbers; a base.    
Thus, ten is the radix or base, of the common system of logarithms and also of the decimal 
system of enumeration.



RAM

An acronym for Random Access Memory.



RAM base address

An acronym for Random Access Memory base address.



RAM drive

A portion of RAM memory that is used as if it were a hard disk drive.    RAM drives are much 
faster than hard disks because the computer can read information faster from RAM memory than
from a hard disk.    Information on a RAM drive is lost when you turn off or restart your computer. 
Also known as virtual drive.



RAMDRIVE.SYS

A DOS file that creates a virtual disk drive in your system's RAM to simulate a hard disk drive.



random access memory (RAM)

A computer memory that stores and recalls information in any order or sequence.    This type of 
memory is used for temporary information storage.    Access to and from RAM memory is very 
fast.    RAM requires electrical power to remember information and all information in RAM is lost 
when the power is turned off.



Random Access Memory base address (RAM base address)

Starting address for memory dedicated to a specific task.



raster font

The font that is displayed on your screen which may approximate a printer font so that 
documents look approximately the same on the screen as they do when printed.    Also called 
screen font.



RD

This DOS command removes (deletes) a directory.    Before using this command, all files and 
subdirectories must be deleted and the directory to be removed must be empty.



read

The process of retrieving information from a circuit or disk.    The original information is not 
altered during the reading process.



read only attribute

A flag that prevents a file from being modified.    A file with this flag set can be viewed, copied or 
printed only.



Read Only Memory (ROM)

A computer memory that stores permanent information.    This information is constant and cannot
be erased, or changed, or lost, even if electrical power is turned off.    All PC's contain programs 
in ROM that execute when the power is turned on (BIOS.)



real mode

CPU (Central Processing Unit) mode in which applications have direct access to the physical 
memory of the computer.



real time

An action at a speed commensurate with the time of occurrence of the actual process.



real time clock

A time counter used to measure the duration of an event.



record

To enter or save data.    In a database application, the records are the rows (horizontal rows) of 
information contained in the database.



record locking

A method of managing shared data on a network by preventing more than one user from 
accessing the same segment of data at the same time.



RECOVER

This DOS command recovers readable information from a bad or defective disk.    This DOS 
command reads a file sector by sector and recovers data from the good sectors.    Data in bad 
sectors is lost.    All recovered data is restored to the root directory.



redirector

An application that intercepts requests for resources local to a node on the network and redirects
those requests elsewhere on the network.



reduce

To minimize a window to an icon.    A minimized application continues running, and you can 
select the icon to make it active again.



refresh rate

This is the speed at which the screen is repainted.    Usually, the faster the refresh rate, the less 
flicker a monitor has.    Typically, color displays must be refreshed at 60 times per second (60 
Hertz).    Also called Vertical Scan Rate. 



REM

A DOS command that enables you to include comments (remarks) in a batch file, 
AUTOEXEC.BAT or CONFIG.SYS files.    DOS ignores any batch command that begins with 
REM.



remote

A system, program or device that is accessed through a telecommunication line.



Remote Procedure Call (RPC)

A protocol governing the method with which an application activates processes on other nodes 
and retrieves the results.



removable disk

A flexible magnetic disk made of plastic and coated with a magnetic material.      The disk can be 
inserted in and removed from a floppy disk drive.    Also called a diskette or floppy disk.



REN

A DOS command that renames a file or files.    This is the same as RENAME



RENAME

A DOS command that renames a file or files.    This is the same as REN.



repeater

A device that regenerates and often amplifies signals to extend transmission distance.    It is 
independent of protocol and media.



Replace

This choice in the Edit Menu allows you to look for certain text in your document and 
automatically replace it with new text that you specify.    The replacement can be done in the 
entire document automatically or you may elect to confirm each replacement manually.



REPLACE

This DOS command replaces files in the destination directory with files in the source directory 
that have the same name.    You can also add unique file names to the destination directory.



replaceable parameters

Replaceable parameters (%0 to %9) are placeholders for parameters typed at the command 
prompt.    The %0 parameter substitutes for the name of the batch command as it is typed at the 
command prompt and %1 through %9 are the parameters typed after the batch command name.



reset

To return a device to its default settings.



resolution

The measure of sharpness of a display image.    The number of dots or pixels on the screen.    
The more dots yield a finer resolution.



response time

The time required between transmission of the last character of a message and reception of the 
first reply character.



RESTORE

A DOS commant that restores files that were backed up by using the BACKUP command.    You 
can restore files from similar or dissimilar disk types.



restore button

The small button containing both an up and down arrow at the right of the title bar.    This button 
only appears after you have enlarged a window to its maximum size.    You can click the restore 
button to return the window to its previous size.



Retrieve

This choice in the File Menu allows the user to call up an existing document on disk and insert it 
into the current document at the location of the cursor.    This change made to the document 
should be saved to disk using the "Save" feature.



RFC

An acronym for Request for Comment.



RGB Monitor

(Red/Green/Blue) A CGA compatible monitor limited to a 15,750 kHz horizontal scan rate.



right click

To press and release the right mouse button while pointing at an object.



ring topology

A network topology in which nodes are connected to a closed loop.    Terminators are not 
required because there are no unconnected ends.



RISC

A specialized type of processor that has been designed to handle a smaller set of instructions for
increased efficiency and performance.



RMDIR

A DOS command that removes (deletes) a directory.    Before using this command, all files and 
subdirectories must be deleted and the directory to be removed must be empty.



ROM

An acronym for Read Only Memory.



ROM Caching

The process of copying the contents of ROM into the faster RAM.



root directory

The top level directory of a disk.    The root directory is created when you format the disk.    From 
the root directory, you can create files and other directories.    The root directory is designated by 
a backslash (\).



route discovery

Process through which a brouter can learn LAN topology by passing information about its 
address and the LANs it connects, and receiving the same information from others.



router

A device that connects networks and supports the required protocols for packet filtering.



RPC

An acronym for Remote Procedure Call.



RS232

The electrical standard for connecting serial data communication equipment.



run

To start the operation of a program.    To begin execution of a computer program.



Run

This choice in the File Menu of the Windows Program Manager allows the user to enter a 
command line instruction just as he would at a DOS prompt.



save

To copy information (document, spreadsheet, etc.) from RAM memory to disk for storage and 
retrieval at some other time.    Remember, it is important to save your work often.    Disk storage 
is permanent, whereas RAM memory is volatile and will be lost when the computer power is 
turned off.



Save

This choice in the File Menu will save any changes made to the current document.    Note, if the 
document has not been previously saved, usually, the "Save As" feature will automatically be 
activated which allows you to name your document.    Sometimes, the new file is simply saved as
"untitled."



Save As

This choice in the File Menu allows the user to name and save the current document.    This 
feature is useful to save an existing document as a different file name.    When this is done, the 
original file remains intact under the original name.



scalable typeface

A set of letters, numbers and symbols that are a given design but can be scaled to any size.



scaled point size

A point size that approximates a specified point size for use on the screen.



scanner

This is a hardware device that converts the printed image on a piece of paper into a computer 
graphics file.    Graphics software can be used to copy, manipulate or transform graphics or 
picture images.    OCR (optical character recognition) software can be used to convert text into a 
word processor format.    The scanner, similar to a copy machine, performs the opposite function 
of a printer.    The printer produces a paper copy of a computer file and the scanner produces a 
computer file of a paper image.



screen

Another name for the monitor display.



screen dump

To view or print information exactly as it appears in its original form.    A screen dump usually 
means to print the information exactly as it is displayed on the monitor screen.    This action is 
usually performed by pressing the "Print Screen" button on the keyboard.



screen font

The font that is displayed on your screen which may approximate a printer font so that 
documents look approximately the same on the screen as they do when printed.



screen saver

A moving picture or pattern that appears on your screen when you have not moved the mouse or
pressed a key for a specified period of time.    Screen savers prevent screen damage that is 
caused when the same areas of light and dark are displayed for long periods of time.



scroll

To move through text or graphics in order to see parts of the file or list that cannot fit on the 
screen.    (As in "pg dn" or arrow key)



scroll arrow

An arrow on either end of a scroll bar that you use to move through the contents of the window 
or list box.



scroll bar

A bar that appears at the bottom and/or right edge of a window whose contents are not entirely 
visible.    Each scroll bar contains a scroll box and two scroll arrows.



scroll box

In a scroll bar, the small box that shows the position of information currently in the window or list 
box relative to the contents of the entire window.



SCROLL LOCK key

This key is used in some software programs to perform special functions and expand the usage 
of some of the standard keys.



SCSI

An acronym for Small Computer System Interface (pronounced skuzzy).    An interface type for 
computer adapters and controller boards.    A standard, intelligent, fast and multitasking I/O 
interface for connecting PC's and peripheral devices.    A standard interface that connects hard 
disks and other devices to the computer.



SCSI Bus Master

A high-performance method of data transfer in which the host adapter's onboard processor 
handles the transfer of data directly to and from a computer's memory without intervention from 
the computer's microprocessor.    This is the fastest method for data transfer available for 
multitasking environments.



SCSI Host Adapter

A printed circuit board that installs in a standard micro computer and provides a SCSI bus 
connection so that SCSI devices can be connected.



Search

This choice in the Help Menu allows the user to look through a list of help topics or type in the 
topic of interest in an effort to find the description of the help topic desired.    This choice in the 
Edit Menu moves the cursor to the first occurrance of a word or phrase you specify.    The "repeat
last find" function moves to the next occurrance, etc.    This is usually the same as the "find" 
feature.



Search Menu

This menu contains typically the ability to find or replace text in a document.    The "find" feature 
moves the cursor to the first occurrance of a word or phrase you specify.    The "repeat last find" 
function moves to the next occurrance, etc.    The "replace" function allows you to look for certain
text in your document and automatically replace it with new text that you specify.    These menu 
choices are sometimes part of Edit Menu.



sector

In the formatting process, the disk is divided into pieces of storage that can be addressed and 
used by DOS.    The smallest piece of disk storage is called a sector.    A sector is defined as 512 
bytes of storage (Sector = 512 Bytes).



sectors per cluster

The number of sectors per cluster contained on the disk in question.    In other words, the 
number of sectors contained in each cluster of a disk.



security management

Protects a network from invalid accesses.    It is one of the management categories defined by 
the ISO.



seek time

The time required for the access arm of a direct access storage device to be positioned on the 
appropriate track.



SEF

An acronym for Source Explicit Forwarding.



select

To mark an item so that a subsequent action can be carried out on that item.    You usually select 
an item by clicking it with a mouse or pressing a key.    After selecting an item, you choose the 
action that you want to affect the item.



selection cursor

The marking device that shows where you are in a window, menu or dialog box, and what you 
have selected.    The selection cursor can appear as a highlight or as a dotted rectangle around 
text.



self test

A method for checking the operation of a device that is initialized by the device itself.



semaphore

A method with which multiple applications can coordinate related operations using messages.



semiconductor

The crystalline substance used to make integrated circuits, transistors and other electronic 
devices.    Technically, semiconductors are manufactured with Silicon and Germanium.    These 
elements are neither conductors nor insulators.    A conductor is a substance, usually a metal, 
which allows electricity to flow through it easily.    An insulator is a substance that prevents the 
flow of electricity.    A semiconductor is a substance that will allow electricity to flow under certain 
conditions and will stop the flow of electricity under other conditions.    These properties are 
useful in computers in that the flow of electricity can be controlled to achieve the output desired.  
For example, transistors are made of semiconductor material so that they can be used as a 
switch in an electronic circuit.



serial data transmission

Bits of data are transmitted one at a time through a single wire.



serial interface

An interface between a computer and a serial device by which the computer sends single bits of 
information to the device, one after the other.    An interface between a computer and another 
device where data is transmitted one bit at a time.    Also called RS232 interface.



serial port

A 25 or 9 pin I/O port on the back of a computer in which data is transmitted and received serially
(COM1 to COM4).    It connects to a cable with a 25 or 9 hole connector (RS232).



server

A computer that provides shared resources, such as files and printers, to the network.    A 
computer that shares its resources with other computers on a network.



server application

An application that creates objects that can be    linked and embedded into other documents.    
See also client application.



session

An active communication connection between nodes.



SET

A DOS command that displays, sets, or removes MS-DOS environment variables.    Environment
variables are used to control the behavior of some batch files and programs and to control the 
way DOS appears and works.    This command is used in the AUTOEXEC.BAT file as well as 
batch files.



setting

A unique characteristic of an object that can be changed or modified.



SETVER

This DOS command sets the version number that MS-DOS reports to a program.    You can also 
use this command to display and modify the version table, which lists names of programs and 
the number of the DOS version with which they are designed to run.



SETVER.EXE

This file loads the DOS version table into memory.



SHARE

This DOS command installs file-sharing and locking capabilities on your hard disk.    Typically, 
this is used in a multitasking environment in which programs share files.    SHARE validates all 
read and write requests from programs.



shared memory

Portion of memory accessible to multiple processes.



shareware

A method of selling and marketing computer software whereby a user may copy the software at 
no charge and use it for a trial period of time before purchasing it.    Users may obtain shareware 
programs by downloading them from a BBS or purchasing copies (for a small fee) from dealers 
or distributors.    If the user decides to keep the software, he may continue to use it by paying the
registration fee to the author.    There is usually a registration form included in a computer file 
with the shareware program.    The shareware system is unique in that the user has the right to 
try the software before he decides to buy it.



SHELL

This DOS command specifies the name and location of the command interpreter you want DOS 
to use.    Typically this is COMMAND.COM.



shielded

Wiring protected from electromagnetic and radio frequency interference by metal hacked mylar 
foil covered by plastic or PVC.



SHIFT

This DOS command changes the position of replaceable parameters (%0 to %9) in a batch file.   
This command copies each parameter into the previous one (%1 is copied to %0 etc.) and it is 
useful for writing batch files that perform the same operation on a number of parameters.



SHIFT key

This key has the same function as the same key on a standard typewriter.    The key is also used
in combination with the function keys and/or the CTRL or ALT keys to provide additional features 
or commands for software programs.    



shortcut key

A key or key combination that you press to carry out a command or action.    If a command has a 
shortcut key, the key combination is listed to the right of the command name on the menu.



shutdown

The procedure required before turning off the computer to ensure that data and configuration 
information are not lost.



Simultaneous Peripheral Operation On-line (SPOOL)

An application that manages print requests or jobs so that one job can be processed while other 
jobs are placed in a queue (An ordered list of items waiting to be processed.) until the printer has
finished with preceding jobs.    Also called print spooler.



single document interface (SDI)

An application program which can only work on a single document or item at a time.    For 
example, the Windows Paintbrush can only work on one graphic at a time.    To work on another 
graphic, the first one must be closed.



Single Sided (SS)

Refers to a disk where the storage medium is present on only one side of the disk.



slack space

The unused portions of used clusters.    The rest of the space left over in the cluster after DOS 
stores a file is called slack space.    It is space on your disk that does not contain useful 
information.    The slack space is there but it cannot be addressed by DOS and cannot be used 
for anything else because DOS cannot get to it.



slider

A control that represents a quantity and its relationship to the range of possible values for that 
quantity.    Used in graphical environments, a slider control looks and operates just like a slider 
control on a home/car stereo system.



Small Computer System Interface (SCSI)

(pronounced skuzzy) An interface type for computer adapters and controller boards.    A 
standard, intelligent, fast and multitasking I/O interface for connecting PC's and peripheral 
devices.      A standard interface that connects hard disks and other devices to the computer.



SMARTDRV.EXE

This DOS file creates a disk cache in extended or expanded memory.    A disk cache can 
significantly speed up DOS disk operations.



soft font

Optional fonts shipped as files and copied onto the hard disk before they can be selected by 
programs.    Also called downloaded fonts.



software

A collective term for programs, operating instructions and other documentation associated with 
the operation of a computer.    A sequence of instructions that a computer can interpret and 
process.    These instructions make the computer hardware perform tasks.    Also called program 
and application.    Device drivers and operating systems are also called software.    Purchased 
software includes the diskettes containing the program and usually the documentation describing
how to use it.



solid color

A color that appears on a display when all pixels are the same color.



solid state

A reference to electronic components or complete circuits made from semiconductor    
substances.



SORT

A DOS command that reads input, sorts data and writes the results to the screen, a file or 
another device.    SORT rearranges characters in ascending or descending order.



sound driver

A program that applications use to play sounds on your computer.



sound file

A file containing audio information that an application can play on your computer.



source

The original document, file or directory from which further copies are made.



source directory

The directory that contains the file or files you intend to copy or move.



source diskette

The diskette from which information is read.



source document

The document from which a linked object originates.



source drive

The drive from which information is read.



Source Explicit Forwarding (SEF)

Security feature that allows transmissions only from specified stations to be forwarded by 
bridges.



special characters

Characters not found on your computer's keyboard.    These are accessible through Character 
Map in Windows or a key combination of ALT and the ANSI character number on the number 
pad.    To type a special character, press and hold down the ALT key and, with the Number Lock 
activated, press the ANSI number of the character on the keypad then release the ALT key and 
the special character will be typed into your document.



split bar

Divides a window into two parts.    You can click and drag the split bar to change the sizes of the 
two divisions.    The Windows File Manager uses a split bar between the directory tree and the 
contents of the current directory.



SPOOL

An acronym for Simultaneous Peripheral Operation On-line.    An application that manages print 
requests or jobs so that one job can be processed while other jobs are placed in a queue (An 
ordered list of items waiting to be processed) until the printer has finished with preceding jobs.    
Also called print spooler.



spooler

A program that intercepts data going to a device driver and writes it to disk.    The data is later 
processed when the device is available.    A spooler prevents output from different sources from 
being intermixed.



spooling

The process of temporarily storing print jobs while waiting for an available printer or port.    
Spooling jobs (tasks) frees system resources from waiting for a relatively slow device to provide 
output and keeps the contents of each print job separated from the contents of every other print 
job.



spreadsheet

A software program that organizes tables of numbers or words in neat rows and columns.    You 
can easily total a column of numbers and perform many different mathematical calculations on 
blocks of numbers.    This is similar to a database program except that the data is stored in RAM 
instead of written directly to disk and the spreadsheet is more oriented to numbers whereas the 
database is more oriented to words.    Still many of the same functions are available in both.



SQL

An acronym for Structured Query Language.



SS

An abreviation for Single Sided.



STACKS

This DOS command supports the dynamic use of data stacks to handle hardware interrupts.    
You can specify the number of stacks and the size in bytes of each stack.



standard mode

A Windows operating mode.    This mode provides access to extended memory and also enables
you to switch between non-Windows applications, but it does not provide virtual memory or 
enable non-Windows applications to run in the background or in a window.    See also 386 
enhanced mode.



standby position

The state of a device whereby it is activated, initialized and ready to operate pending the proper 
commands from the computer.    In the case of a printer, the paper is ready to be loaded, but not 
in the paper path yet.



star topology

A network topology in which nodes are connected to a common device such as a hub or 
concentrator.



start up sequence

The order that the computer uses to search the direct access storaee devices for an operating 
system.



statement

A line in a computer program.



status bar

A line of information usually located at the bottom of a window.    The status bar, when used, may
contain the date, the state of the number lock, scroll lock and caps lock keys as well as a short 
description of where you are in the software or a short help description of the action that is 
currently highlighted.    In only a few applications, the status bar may also contain buttons which 
allow you to change features in the program like font, toolbar set up, point size, etc.



store

To remember a piece of information.



store and forward

A message switching technique in which messages are temporarily stored at intermediate points 
before being retransmitted to the next destination.



stored procedures

Compiled code residing on an intelligent database server that reduces the processing burden on 
the client.



string

A group of characters separated by spaces.    These are used to enter commands for a program.



Structured Query Language (SQL)

A widely used programming language for manipulating database information.



subdirectory

A directory within another directory.



subscript

Printing in which each character is printed at about two-thirds the normal height in the lower part 
of the character space.



SUBST

A DOS command that associates a path with a drive letter.    The drive letter assigned represents
a virtual drive, because you can use the drive letter in commands as if it represented a physical 
or logical drive.



Super VGA

An acronym for Super Video Graphics Array.



Super Video Graphics Array (SVGA) or Super VGA

This is a VGA monitor that supports a maximum resolution of 1024 x 768 pixels in 256 colors.



superscript

Printing in which each character is printed at about two-thirds the normal height in the upper part
of the character space.



SVGA

An acronym for Super VGA or Super Video Graphics Array.



swap file

A file created on your hard disk by Windows, OS/2 or an application to temporarily store 
information to free RAM memory for other information.    The swap file information is transferred 
between RAM and the hard disk as needed to accomplish the tasks you request.    Swap files 
may be temporary or permanent.



switch

An additional parameter added to a command line to control how a command is carried out.    
Switches (also called optional parameters) usually follow a space and a forward slash (/).



SWITCHES

This DOS command forces an enhanced keyboard to behave like a conventional keyboard and 
use conventional keyboard functions.



synchronous transmission

A data transmission scheme in which the interval between transmitted characters is fixed so that 
start and stop bits are not required.



syntax

The grammar rules of a computer.



synthesizer

A device that produces sound from digital instructions rather than from recorded sound.



SYS

This DOS command copies DOS system files and command interpreter to a disk you specify.    
The disk now becomes a bootable disk.



system

All of the computer hardware and software that is installed or connected.    Your computer 
universe.



system attribute

A flag that indicates that a file or directory is part of the operating system.



system boot up sequence

This is a setting in the BIOS of your computer that establishes the sequence that will be followed
to start the operating system.    The sequence is usually specified as "A:, C:", which means that 
your computer will look first at your "A" drive for a bootable disk, then finding none, it will look at 
your "C" drive to start the operating system.



system date

The current date according to your computer's internal clock which is part of your BIOS.



system disk

A floppy disk that you create that contains the operating system files necessary to start the 
operating system from the floppy drive.    A system disk, usually, will only start your computer 
from your "A" drive.



system file

A file that contains information required for running the operating system.    A    system file has the
system attribute set so it does not usually show up in a directory listing.



system icon

In Windows, the icon in the upper left corner of the window that you can use to display the 
system window menu or close the window.



system menu

A menu that contains commands you can use to manipulate the window.    Application icons and 
some dialog boxes also have a system menu.    To open the system menu, click the application 
icon or the upper left corner of the window.    Also called a control menu.



system time

The time according to your computer's internal clock which is part of your BIOS.



SYSTEM.INI file

A Windows initialization file that contains settings that instruct Windows on how to communicate 
with your system's hardware.    This is a simple text file which you can modify manually if you are
sure that you know the effect of what you are doing.    As always, you should make a backup 
copy of the original file before you change it, in case the changes do not work or do not have the 
desired effect.



T connector

A "T" shaped device with two female and one male BNC connectors.



T1

A 1.544 megabits per second multichannel transmission system for voice or data provided by 
long distance telephone carriers.



tab

Moving the cursor with the TAB key.    Also, a graphical representation of a book-like tab on a 
notebook that, when selected, turns the notebook page.



TAB key

This key performs the same function as the same key on a typewriter.    It is also used in a 
Windows application to move from one data entry field to the next.



tab stop

The location in a document where the characters will appear after you press the Tab key.



target

The location where you intend a copy of a document or file to be placed.



target directory

The directory where the information will be written.



target diskette

The diskette to which information is written.



target drive

The drive to which information is written.



task list

A window in Windows or OS/2 that shows all the applications you have running and enables you 
to switch between them.    You can open the task list by pressing CTRL+ESC.



tear-off

A feature of a printer that automatically feeds the perforation of continuous paper to the tear-off 
position for separation and then feeds the paper back to the loading position.



tear-off position

The position to which the printer feeds continuous paper when the user presses the TEAR OFF 
button.    This position can be adjusted using the micro-adjustment feature so that the paper's 
perforation meets the printer's tear-off edge.



template

An object used in OS/2 that you can use as a model to create additional objects.



terminal

An input or output device connected to a computer which is capable of sending and receiving 
information.    A terminal is usually an input device, like a keyboard, and an output device, like a 
monitor, associated with a multiple user business computer system.



Terminate and Stay Resident (TSR)

A memory resident program that remains active in memory when other programs are running.    It
is not visible until you press a certain key combination or until a certain event occurs.    A typical 
example is a screen saver program that will activate after a certain time period, or if the user 
presses a certain key combination.    Also called memory resident or pop up program.



text box

A box in a window or dialog box in which you can type information needed to carry out a 
command.    The text box may be blank or may contain text when the window or dialog box is 
opened.    A text box is usually single line.    Multi-line text boxes are also used.    A file editor is an
example of a multi-line text box.    Also called edit control.    (Note: A different definition applies in 
a word processing application.)



text editor

An application used to create, view and modify simple ASCII text files usually having a .TXT file 
extension.    Common examples are EDIT in DOS, NOTEPAD in Windows and the SYSTEM 
EDITOR in OS/2.



text file

A file containing only letters, digits and symbols, but no formatting information except the 
carriage return and tab.    A text file usually consists of characters coded from the ASCII 
character set.    Also known as data file or document file.



text mode

The mode that enables applications to display text but not graphic images.    Most DOS 
programs run in text mode, in contrast to graphics mode.



text transfer

A method for transferring text files between two computers via modem.



Thicknet

Cabling scheme using twinaxial cable.



Thinnet

Cabling scheme using 50 ohm coaxial cable.



threads

Individual processes within a single application.



TIFF

An acronym for Tagged Image File Format, is usually created by scanners or image processing 
programs.    These bitmapped files come in a number of different versions.



tightly coupled

A multiprocessor computer in which the CPUs (Central Processing Units) share memory and one
system bus.



Tile

A choice in the Window Menu that modifies the size of each window and arranges them so that 
they are all visible and appear side by side and top to bottom.



time slice

In a multitasking environment, this is the amount of processor time that the operating system 
allocates to an application, usually measured in milliseconds.    Each application can run for this 
specified amount of time before the next application is given control.



time slicing

Dividing a resource so that each application or task that requests the resource is allocated some 
amount of time.



TIME

A DOS command that displays or sets the computer's internal clock (system time).    This 
information is used by programs and DOS uses the system time to record when you update or 
change a file.



timeout

The amount of time a computer should wait before detecting device non-performance as an 
error.    For screen savers, this is the amount of time the computer should wait (after the last user
action of keyboard or mouse) before activating the screen saver program.



title bar

The area at the top of each window that can contain the window title, system icon in Windows 
(title bar icon in OS/2), minimize and maximize buttons.



title bar icon

In OS/2, the icon in the upper left corner of the window that you can use to display the pop up 
window menu or close the window.



toggle

A feature or key that is turned on or off with the same keystroke.    If the feature or key is on, 
pressing the keystroke turns it off.    If the feature or key is off, pressing the keystroke turns it on.



token

The character sequence passed among nodes in sequence to indicate which one has 
permission to transmit.



token bus

A bus topology network using a token passing access method.



token passing

A network access method that requires nodes to wait for their turn before transmitting data.    
Turns are indicated by a character sequence that passes from one node to the next.



Token Ring

A 4 megabit per second or 16 megabit per second network using a ring topology and a token 
passing access method.



Tools Menu

If available, this menu usually contains special tools and features that enhance the features of 
the software.    The menu may contain functions that allow you to use a spell check, thesaurus, 
sort, macros, etc.



top of form

The position on the paper that the printer recognizes as the first printable line.    The printer feeds
the paper to this position when it loads the paper.



topology

The arrangement of nodes usually forming a star, ring, tree or bus pattern.    Also called network 
topology.



total files

The number and size of the files already stored on the disk.



tower computer

A personal computer system whereby the main computer is in a case that sits vertically on the 
floor.    The keyboard and monitor only are usually on top of the user's desk.



track

A collection of sectors that will fit into a circle on a disk.



tractor paper (tractor feed paper)

Another name for continuous paper.



transceiver

An AUI (Attachment Unit Interface) device for receiving and transmitting data that often provides 
collision detection as well.



tree topology

A network topology in which nodes are connected by cables to a trunk cable with a central 
retransmission facility.



TREE

A DOS command which will graphically display the directory structure of a drive or path.    This 
command can also display the names of the files in each directory.



triggers

Uncompiled code residing on an intelligent database server.



True Type fonts

Fonts that are scalable and sometimes generated as bitmaps or soft fonts.    True Type fonts can 
be sized to any height and they print exactly as they appear on the screen.    See also printer font
and screen font.



TSR

An acronym for terminate and stay resident.



TTL

An acronym for Transistor-Transistor Logic.    A fast, reasonable cost type of integrated circuit 
used in computer design (Typically 5vDC voltage level).



TTL Monitor

Video and synchronization signals (all digital) are on separate lines and have TTL compatible 
voltage levels.



Tutorial

This choice in the Help Menu activates the tutorial that is included with some software programs.



twisted pair cable

A wiring scheme with one or more pairs of 18 to 24 gauge copper strands.    The strands are 
twisted to improve protection against electromagnetic and radio frequency interference.    Cable 
may be either shielded or unshielded.



type 3

Unshielded twisted pair cable.



type 1

Shielded two pair cable.



TYPE

A DOS command which displays the contents of a text file on the screen.    If the file you want to 
display is long, you can use the MORE command along with TYPE (|MORE) to view the file's 
contents one screen at a time.



UMB

An acronym for Upper Memory Blocks.



UNDELETE

A DOS command which restores files previously deleted with the DEL command.    UNDELETE 
cannot restore a directory that has been removed or restore a file if you have removed the 
directory that contained the file.



Undo

This choice in the Edit Menu will reverse the last operation performed by the user including the 
typing or deleting of text or a clipboard operation.    Some programs only have one level of 
"undo."    In other words, continued selection of the "undo" feature will toggle between the last 
and next to last operation.    Some software has a limited number of levels of "undo" wherein the 
user is able to undo the last 3, 4 or 5 operations.    The number of levels is usually selectable by 
the user.    Some software even has unlimited levels of "undo" wherein the user can undo all 
operations in the document all the way back to a blank document which contains nothing.



UNFORMAT

A DOS command which restores a disk erased by the FORMAT command or restructured by the 
RECOVER command.



uni-directional printing

Printing in one direction only.    This is useful for printing graphics and letter quality documents 
because it allows more precise vertical alignment than bi-directional printing.



Uninterruptible Power Supply (UPS)

Battery backup system to provide continuous power in the event of power failures or fluctuations.
Particularly important for network servers, bridges and gateways.



unity gain

Refers to the balance between signal loss on a broadband network and signal gain through 
amplifiers.



unshielded

Wiring not protected from electromagnetic and radio frequency interference but covered with 
plastic and/or PVC.



upload

The act of transferring computer files from an individual's computer to a bulletin board (BBS).



upper memory area

The 384KB area of address space above the 640KB of conventional memory.    This area is 
usually reserved for running your system's hardware and is not considered part of total memory 
because applications cannot store information in this area.



Upper Memory Blocks (UMB)

A standard method of managing RAM memory between 640KB and 1 megabyte.    The XMS 
specification allocates this memory in units called upper memory blocks.    These upper memory 
blocks hold device drivers and other memory resident programs in order to leave more 
conventional memory available for applications.



UPS

An acronym for uninterruptible power supply.



used space

The amount of space, in bytes, on the disk that is now being used for storage.    This number 
represents the total space occupied by the number of clusters used.



user

The person (You) who operates a computer.



user interface

The hardware and software that allow you to interact with and perform operations on a computer.



user-defined characters

Characters that are defined and stored in the printer by the user.    Also known as download 
characters.



value

A quantity assigned to a constant, a variable or a parameter.



Value Added Process (VAP)

An application designed to load and run automatically on a NetWare server in order to help 
manage resources.



VAP

An acronym for Value Added Process.



vector font

A font created by a series of dots connected by lines that can be scaled to different sizes (used 
by plotters).    Also known as plotter font.



VER

A DOS command which displays the DOS version number.



VERIFY

A DOS command which directs MS-DOS to verify that your files are written correctly to a disk.    It
tells DOS to verify that write operations to disks are done correctly.



VESA (Video Electronics Standards Association)

This Association is responsible for setting standards in all areas of graphics and video 
technology.



VGA

An acronym for Video Graphics Array.    Analog graphics standard introduced with the IBM 
PS/2 series computers. Compatible with EGA but has higher resolution. Supports a maximum 
resolution of 640 x 480 pixels in 16 colors.



video monitor

The television-like device on which computer information is displayed on a screen.    Also called 
a monitor.



view

The appearance of the contents of an object.



virtual

This term is used to describe computer memory or a computer storage location that is used to 
simulate another type of memory or storage even though the other type does not physically 
exist.    For example, Windows uses a hard disk to simulate and augment RAM memory.    In this 
case, the hard disk storage is said to be "virtual" memory.



virtual circuit

A communications link that appears to be a dedicated circuit and passes sequential packets 
between devices usually in a packet switching network.



virtual drive

A portion of RAM memory that is used as if it were a hard disk drive.    RAM drives are much 
faster than hard disks because the computer can read information faster from RAM memory than
from a hard disk.    Also known as RAM drive.    Information on a RAM drive is lost when you turn 
off or restart your computer.



virtual memory

A memory management system used by Windows in 386 enhanced mode that enables Windows
to run as if there were more memory than is actually present on your computer.    The amount of 
virtual memory available equals the amount of free RAM plus the amount of disk space allocated
to a swap file that Windows uses to simulate additional RAM.



virus

A purposely destructive computer program that can grow inside a computer by modifying other 
computer programs.



VL-Bus

A specification for a local-bus developed by the VESA local bus committee.



VOL

A DOS command which displays a disk volume label and serial number if they exist.



volatile

A term used in reference to a computer memory that requires electrical power to retain 
information.    The random access memory in a personal computer is volatile memory.



volume label

A name that identifies a disk.



VSAFE

A DOS command which continuously monitors your computer for viruses and displays a warning 
when it finds one.



wallpaper

An image being displayed on the Windows desktop background.



WAN

An acronym for Wide Area Network.



warm boot

The process of restarting the computer without reloading the operating system.    A warm boot is 
accomplished by pressing key combination CTRL+ALT+DEL.    System RAM is not rechecked 
with a warm boot.



waveform

A graphic representation of the shape of a wave that indicates its characteristics, such as 
frequency and amplitude.    Also, a digital method of storing and manipulating audio data within a 
computer.



Wide Area Network (WAN)

A network capable of transmissions over large geographic areas that uses transmission lines 
provided by a common carrier.



wildcard character

A question mark (? represents a single character) or an asterisk (* represents a whole word or a 
group of characters) used as a variable in a file name or file name extension when referring to a 
particular file or group of files.    The wildcard "*.*" refers to all files.



WIN.INI file

A Windows initialization file that contains settings that instruct Windows on how to start up and 
what features to include in your Windows environment.    This is a simple text file which you can 
modify manually if you are sure that you know the effect of what you are doing.    As always, you 
should make a backup copy of the original file before you change it, in case the changes do not 
work or do not have the desired effect.



WIN-OS/2

A feature of OS/2 that enables OS/2 to run supported Windows programs.



window

An area of the screen with visible boundaries within which information is displayed.    A window 
can be smaller than, or the same size as, the screen.    You can open, close or move windows, 
and you can change the size of most windows.    You can open several windows at a time and 
you can often reduce a window to an icon or enlarge it to fill the entire screen.    Sometimes 
windows are displayed within other windows.    Windows can appear to overlap on the screen.



window list

A menu choice (or ALT+ESC hot key) that displays a list of all of the open windows in an 
application or the Program Manager.    You use the window list to switch to another active 
program or close a program.



Window List

This choice in the Window Menu is a list of all open windows (documents) in the application.    
This window list allows the user to quickly switch the active window to any window on the list.



Window Menu

This menu is usually available in a multiple document interface (MDI) application.    It contains 
the commands to cascade and tile open windows as well as arrange the icons of minimized 
windows.    This menu usually contains a window list of all open windows in the application.    This
window list allows the user to quickly switch the active window to any window on the list.



Windows application

An application that is designed to run with Windows or WIN/OS2 and does not run in any other 
environment.    All Windows applications follow similar conventions for arrangement of menus, 
style of dialog boxes and keyboard and mouse use.



Windows character set

The character set used to display Windows and Windows applications.    It is based on the ANSI 
character set.



WMF

Windows Metafile (.WMF) is a popular vector format for Windows graphics files.



word processing

A method of using a computer as an electronic typewriter with a built-in memory and editing 
capabilities.    Word processing speeds the process of error-free text.



word processor

An automated, computer software system for producing typed documents, such as letters, 
reports, etc.    A computer program used to create, edit, format and print text documents.    There 
are many word processing programs available, with capabilities ranging from primitive to 
extremely sophisticated.    Word processors are usually distinguished from editors by having the 
capability to automatically format paragraphs, margins and control other appearance 
characteristics of the document.



word wrap

A feature that moves text from the end of a line to the beginning of a new line as you type.    With
word wrap, you do not need to press Enter at the end of each line of type.



working copy

A duplicate of a program diskette for daily use.    Working copies, rather than originals, are used 
for the same reason backup copies are made.    Diskettes are prone to deteriate over time, and 
working copies save the wear and tear on your original diskette.



working directory

A specified directory that becomes the current directory when a program is started.



workspace

The area of a window that displays the information contained in the application or document with
which you are working.



workstation

A networked computer typically reserved for end user applications.



WPG

Word Perfect Graphics format (.WPG) can be vector or bitmapped graphics.    Sometimes they 
are a combination of the two.



write

To store information in a computer memory device.



write enable notch

A slot on the side of a 5 1/4" disk or coverable square hole on a 3 1/2" disk that permits the 
diskette to be written on.    When the notch is covered or the square hole opened, writing is not 
permitted.



write protect

Allows reading from a diskette but prevents writing to the diskette.



WYSIWYG

An acronym for What You See Is What You Get.    Pronounced "wissywig" or "wizzywig." Refers 
to the ability to display a close representation of the printed page on the computer screen.



XCOPY

A DOS command which copies all files except hidden and system files.    You can copy all the 
files in a directory as well as in its subdirectories.



XMS

An acronym for Extended Memory Specification.




